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Introduction
Thank you for becoming a front office with Open and Affordable Dental. This is an exciting opportunity and
career. This job is very rewarding once you become amazing. Until you become amazing, have a positive
mental attitude during the steep learning curve of training. Many jobs you may have had in the past did not
require the amount of knowledge, effort, and patience the dental front office requires. Be patient with
yourself during your training. It takes many fronts 6 months to master all the tasks required of a front office.
Become amazing at every aspect of your job. Be proud of your own work. We ask that you be committed to
showing up, working hard, and helping us create a perfect patient experience. During your training, it is
expected you show up on time; if you do not show up for any reason, you may be let go immediately.

Manual Designations
Designations are used within this manual to facilitate accelerated training.

Designation Explanation Example

Heading 1
Heading 2
Heading 3

Table Headings

Bold Screens, buttons, and selections Pref. Name field

<<Carrots>> Parameters <<Date of Birth>>

Highlighted Appointment Types HYGIENE - Prophy (Adult) - OP1

Links Links to online resource www.openandaffordable.com

▶Link Links to videos ▶Link to Website Overview Video

“Quotes” Things typed or said “Open and Affordable Dental, this is Jason,
how may I help you?”

Job Description
The front office plays a critical role in the success of the practice. The front office is the first point of contact
for the patient both in person and on the phone, thus requiring an attitude that portrays confidence and
positivity. Appropriate professional attire is required. It is imperative that the front office be well organized,
be able to multitask, and be able to work well with providers and other staff. The front office needs to be
able to understand and communicate dental treatment in a way the patient feels the entire office is
available and capable of solving their dental needs. The following is a guide to help in understanding the
various functions of the front office staff. It is imperative that all processes be understood and followed to
prevent mistakes that require 10 times more work and time to fix than if they had been done correctly the
first time.

Attire Guidelines
You will be interacting with patients, it is appropriate to look the best you can. All employees should
maintain a well groomed professional appearance. Business casual attire or smart casual attire is
appropriate for the front office. See the infographic below for examples of both types of attire. Questions
should be directed to the doctors or a member of the corporate staff should any questions arise over the
appropriateness of a staff member's attire.
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Acceptable attire includes Unacceptable attire includes

✔ Slacks
✔ Button-up shirts or blouses
✔ Polo style shirts
✔ Knit sweaters
✔ Dresses or skirts that at least fall to

knee-length

Jeans
Tennis shoes
T-shirts
Low-cut shirts or blouses
Tank tops
Hoodie type sweaters
Excessive cologne, perfume, or make up

Workspace Guidelines
It is important to keep food and drinks with aroma out of the front office. All aroma producing food should
be eaten in the break room. All drinks should be consumed in non-transparent containers. Non-aroma
producing snacks such as granola bars and fruit snacks may be consumed at the front office as long as
they don’t produce crumbs. Hands should not touch the mouth and then touch the keyboard. All employees
must thoroughly wash hands after eating and restroom use. All front office areas should be well organized
and should have minimal clutter, especially sticky notes.

OSHA, HIPAA, & CPR
All new hires need to complete the following courses within 60 days of hire. The cost of the courses are
paid for by the office. Discuss with your doctor to provide you with the company credit card for payment.
Complete the training during down times. All certificates need to be uploaded to the employee’s EagleSoft
SmartDoc.

● OSHA and HIPAA: www.MyDentalCE.com → New Hire & Existing Staff Bundle: OSHA Video &
HIPAA (Recertification once per year). $29.00 per certificate. Required within 10 days of hire and
yearly thereafter.

● CPR: www.nationalcprfoundation.com → Basic Life Support (BLS) (Recertification every two years).
$14.95 per certificate. Save 10% Code: CPR10. Required within 90 days of hire and every two
years thereafter.

Open and Affordable Dental and Braces Website
Familiarize yourself with the website, www.openandaffordable.com, as it contains documents and
information that help you to direct patients for care. The website contains information such as office contact
information, doctors practicing at each office, office addresses, training manuals and links to videos,
procedure instruction forms, post operative instruction forms, frequently asked questions, and the ability to
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chat with answering service. An important page on the website is the Office Access page that contains all
documentation for Open and Affordable Dental and Braces.

▶Link to Website Overview Video

Office Communications
Open and Affordable Dental uses the Signal application to facilitate office communications. Signal has both
a desktop and a mobile application. The desktop application can be downloaded from this link. You may be
invited to download the application and join office specific groups that allow you to communicate with
different functions within Open and Affordable Dental.

The Value of New Patients
New patients are the lifeblood of any successful practice. Open and Affordable Dental and Braces strives to
attract and retain as many patients as possible. In monetary terms, a new patient brings roughly $1,000 in
immediate revenue to the practice and many times that amount over the life of the patient, especially when
considering potential referrals of family and friends. The front office is the first contact with new patients
and needs to be proactive in converting potential patients to actual patients. It cannot be emphasized
enough how important it is to convert potential patients to actual patients. It is Open and Affordable Dental
and Braces’ policy to see any emergency patient as soon as they can be seen. If patients are shopping for
prices, it can be mentioned that the doctor wants to ensure they’re out of pain and can work with them to
get them out of pain on any budget. If the patients are price shopping for larger priced items such as
crowns or bridges, it can be mentioned that their being a patient of the practice is important to the doctor,
and the doctor can work with their budget to address their need. All prices are negotiable by the doctor. If
patients are traveling from a distance, it can be emphasized that their appointment will be worth the travel
time, and we will see them when they get here. If no hygiene appointments are available by the end of next
week, the patient can be seen and cleaned by the doctor at any available doctor appointment time. Patients
with little money can be made aware of our $29 new patient fee, which includes all needed xrays and
exams. All new patients walking in the door should be imagined with 25 of their family and friends walking
in behind them all wanting to be seen. This image of a patient with their 25 friends and family is how
important a new patient is to a successful practice. There is very little as far as scheduling, distance, or
prices that should get in the way of seeing a new patient, their family, and friends.

▶Link to The Value of New Patients Video

Patient Flow Through Office
The patient flow is critical in establishing and maintaining a positive patient experience. Each patient touch
point has been thoroughly tested to ensure proper communication before, during, and after the patient visit.
Ensure each step is being followed at each visit to maximize efficiency and patient experience. Patient
feedback signs are posted throughout the office to encourage system improvement. These signs display a
QR code that directs to the Open and Affordable Dental’s Feedback Page. This page anonymously gathers
feedback from patients.

1. Inbound phone call with correct dialogue, obtaining insurance information for verification
2. Scheduling according to scheduling protocol
3. Insurance is verified
4. Confirmation texts sent out at 4 weeks and 3 days automatically updating confirmation status
5. Confirmation calls are made to anyone not responding to confirmation texts, appointment notes

made for any communication between front and patient
6. Patient arriving on time and New Patient Forms filled out before appointment start time
7. Routing sheet delivered after New Patient Forms are completed and insurance verified
8. Assistants greeting and seating patients with correct dialogue
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9. Assistants introducing patient to provider with correct dialogue
10. New patient introduction by provider, informs patient of practice availability, gives new patient after

hours number, and requests referrals
11. Correct xrays are ordered, then diagnosis is made
12. Financial concerns are discussed with patient before agreeing to treatment
13. All administrative tasks are completed, especially scheduling the recall visit BEFORE any procedure

is initiated. Doctor double checks the routing sheet and recall status BEFORE beginning the
procedure.

14. Patient is never pushed clinically nor financially and is treated as we would treat our own mother. All
procedures are completed ideally within an hour

15. Provider walks the routing sheet to the front and communicates any financial arrangements to the
front. Routing sheet follows the patient at every step of the process.

16. The front takes the patient payment (if needed)
17. Assistant completes chart notes, delivers any lab claims to the outbound lab transfer box, and

sends a request for feedback and/or practice review
18. Doctors make post operative calls
19. Front Office and/or Accounts Receivable send out insurance claims
20. Front Office and/or Accounts Receivable processes inbound insurance payments
21. Front Office/Accounts Receivable/Providers monitor account balances, payments, and claim

rejections
22. All office personnel, fronts, assistants, and providers complete daily and weekly check off lists

Answering Frequently Asked Questions
Frequently asked questions and answers are found on the Open and Affordable Dental FAQs page located
at: https://www.openandaffordable.com/frequently-asked-questions. Review these questions and their
answers often, as they are updated frequently. It is important to use these prescribed answers during
patient calls. Any patient questions not found on this webpage should be updated by emailing
corporate@openandaffordable.com or through your office’s corporate Signal group chat.

Inbound Telephone Calls
All inbound calls should be answered within 3 rings. Calls not answered within 3 rings are configured to be
forwarded to the Open and Affordable Dental Answering Service. All calls placed within open business
hours ideally should be answered by the office the patient is calling. Since all calls are automatically
forwarded after the 3rd ring to the answering service, there is no need to change phone forwarding settings
when the office is closed. If the office is temporarily closed for staff meetings, alert Open and Affordable
Dental Answering Service of the meeting, and the phones may be silenced.

Inbound Telephone Call Dialogue
The inbound phone greeting should contain three parts:

In-Office Answering service
1. Open and Affordable Dental.
2. This is <<your name>>.
3. How may I help you?

1. Open and Affordable Dental.
2. This is <<your name>>.
3. How may I help you?
4. Patient explains the issue.
5. At which office are you usually seen?

Common Errors: Not saying the word “Dental”. Not saying your name. Not saying, “How may I help you?”

Putting Calls On Hold
Occasionally more than one call will ring simultaneously. The clinical staff should have access to a cordless
clinical phone and should attempt to take calls if the fronts are busy with other calls. It is encouraged that
doctors take inbound calls as their conversion rate is high. It is appropriate to request the current call to
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hold while you answer the next call using the phrase, “May I put you on a brief hold?” Request help from
other staff members if the call will be on hold for an extended period of time.

Upset Patient Inbound Phone Call
Occasionally patients will become upset about their experience with Open and Affordable Dental. All
patients are alerted that the inbound phone call is recorded. It is important to remain calm and professional
during the phone call. Many times it is best to get the patient’s phone number and have the doctor call the
patient back. At any time the patient starts raising their voice, using profanity, or makes personal attacks, it
is appropriate to alert the patient the phone call will be disconnected. Make note of the phone call and send
the recorded message to the appropriate doctor. Do not let negative patients affect your morale.

Patient Preferred Doctor
All scheduling should maximize practice efficiency and keep patients with their preferred doctor. Patients
should also be asked if they prefer mornings or afternoons, then scheduled to the closest morning or
afternoon appointment already scheduled. Providers should add patient preferred provider alerts as
needed.

Sample Inbound Phone Call Scripting
Patient: “I would like to schedule an appointment.”
Front Desk: “I’m happy to help you with that! Have you been here before?

Existing Patient: “Do you want a cleaning, or do you have a specific concern you would like
addressed?”

Cleaning: A HYGIENE - Prophy (Adult) - OP1 or HYGIENE - Prophy (Child) - OP2
appointment is scheduled according to the scheduling protocol. Ensure to ask the
patient if want to schedule any other family members at the same time?

Concern: An GP - Emergency (Recall Patient) - OP2 appointment is scheduled according to
the scheduling protocol.

New Patient: “Do you want a cleaning, or do you have a specific concern you would like
addressed?”

Cleaning: “Our new patient appointment includes a complete exam and xrays. I”ll also put a
note here that you want a cleaning. What days and times work best for you?”

A HYGIENE - NP w/ Prophy (Adult) - OP1 or HYGIENE - NP w/ Prophy (Child) - OP2
is scheduled according to the scheduling protocol. Request the patient’s name,
phone number, DOB, and ask if they have any insurance they’d like us to put into the
system. If they don’t have their insurance info available, tell them to arrive 15 to 20
minutes prior to their appointment time, and they can provide it at that time. Try to
find the patient in Eaglesoft. If they don’t exist in Eaglesoft, double click on the
appointment time and create a new patient. New patients are encouraged to be
scheduled with the hygienist unless there is no hygiene availability prior to the end of
the following week. If there is no hygienist availability in that time frame, the
appointment is scheduled with the doctor. Ensure to ask the patient if want to
schedule any other family members at the same time?

Concern: “How soon can you come in? We have some other patients with scheduled
appointments, so there might be a slight wait when you get here, but the doctor wants to see
you immediately.”

A GP - Emergency (New Patient) - OP2 is scheduled according to the scheduling
protocol. Request the patient’s name, phone number, DOB, and ask if they have any
insurance they’d like us to put into the system. If they don’t have their insurance info
available, tell them to arrive 15 to 20 minutes prior to their appointment time, and
they can provide it at that time. If the patient has no insurance and asks what the
cost of the new patient visit is, explain the $29 new patient exam and xray.

12



▶Link to New Patient Intake Call - Family with Insurance Video

Canceling Appointment Requests
Patient: “I would like to cancel an appointment.”

Front Desk: Can I get that rescheduled at a better time for you? If the patient wants to cancel. I’ve
got that appointment canceled for you at this time and we are here anytime for you to reschedule.
Drag the appointment to the NOTES column in OnSchedule above or below the Call to R/S Below
block if appropriate.

Greater than day of appointment: Change the appointment type to NOTES - Excused
Absence and add an appointment note with the original appointment type. Day of
appointment: Change the appointment type to NOTES - No Show and add an appointment
note with the original appointment type.

Reschedule Appointment Requests (GP)
Patient: “I would like to reschedule an appointment.”

Front Desk: “I’m happy to help you with that! What days and times would work better for you?”
Drag the appointment to the NOTES column in OnSchedule above or below the Call to R/S Below
block as appropriate.

Greater than two business days: Simply move the appointment to the new appointment
date and time.
Less than two business days, but greater than day of appointment: Change the
appointment type to NOTES - Excused Absence, and schedule a new appointment at the
new requested date and time.
Day of appointment: Depending on circumstance, designate the appointment as a NOTES
- No Show or NOTES - Excused Absence, and schedule a new appointment at the new
requested date time.

Reschedule Appointment Requests (OS)
Patient: “I would like to reschedule an appointment.”

Specialty Front Desk: “I’m happy to help you with that! What days and times would work better for
you?” Drag the appointment to the NOTES column in OnSchedule above or below the Call to R/S
Below block as appropriate.

Greater than three business days: Simply move the appointment to the new appointment
date and time.
Less than three business days, but greater than day of appointment: Change the
appointment type to NOTES - Excused Absence, and schedule a new appointment at the
new requested date and time.
Day of appointment: Depending on circumstance, designate the appointment as a NOTES
- No Show or NOTES - Excused Absence, and schedule a new appointment at the new
requested and time.

Edit Patient Window
For New Patients - fill out the following information on the Edit Patient window while on the phone:
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Prefered Name Field
Once the insurance information has been verified, the insurance name is entered in all caps in the Edit
Patient → Preferred Name field (such as DELTA CO for Dental Dental of Colorado, or the Medicaid
Number for Medicaid patients.) Patients with dual insurance coverage will be designated by
“INSURANCE1/INSURANCE2” in the Preferred Name field. Insurance that has not been verified by either
downloading benefit information via the Eaglesoft Eligibility button or downloading from the insurance
company will be designated with a single asterisk in the preferred name field e.g. (*DELTA CO, *AETNA).
All patients who state they do not have insurance (and we did not discuss the in office discount plan) will be
designated using *CASH. All patients interested in, but who have not yet purchased the discount plan will
be designated with *DISI or *DISF as appropriate. All patients who sign up for the individual Open and
Affordable Discount plan will be designated with DISI or DISF as appropriate <Termination Date listed as
MM/DD/YY>. Preferred names such as Jim for James or phonetic spellings will be designated in square
brackets in the first name field e.g. James [Jim].

Procedure Codes
All dental codes will start with the letter “D” and then the following number will dictate what category they
fall into on the listing below.

D0120 - D0999 Diagnostic (Xrays & Exams) D5110 - D5999 Dentures & Prosthodontics

D1110 - D1999 Preventative D6010 - D6999 Implants

D2140 - D2999 Restorative (Crowns & Fillings) D7111 - D7999 Oral Surgery (Extractions)

D3110 - D3999 Endodontics (Root Canals) D8010 - D8999 Orthodontics (Braces)
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D4210 - D4999 Periodontics D9110 - D9999 Adjunctive (Sedation & Occlusal Guard)

Dental Procedure Descriptions
It is important to know dental procedures and the number of appointments required to complete each
procedure. With experience, fronts will also know the dental codes (CDT codes) for each procedure.

Crown (D2740)

Description: A crown is an enamel replacement for teeth that are missing >50% of the tooth structure.
Visits: Requires 2 visits to complete.

1. GP - Crown/Bridge Preparation - OP2 - Some of the enamel is removed from the tooth. The patient
leaves with a temporary crown to cover the prepared tooth. The temporary might be rougher than
the final crown or their natural tooth.

2. GP - Crown/Bridge Seat - OP2 - The lab created final crown is permanently cemented on the tooth.

Root Canal (D3310, D3320, D3310)

Description: Root Canals fall under the Endodontic category of an insurance plan. Root Canals are used
to remove decay that has reached the nerve of the tooth. Root canals are indicated when there is infection
shown on the xray or the patient is in pain that wakes them up at night.
Visits: GP - Root Canal - OP1 - Often done in one visit unless the infection is more rampant. With larger
infections, the doctor may choose to clean and medicate the root canal and bring the patient back for the
final fill, or seal, of the root canal. A crown may or may not be prepared on the same visit.
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Scaling and Root Planing (SRP) (D4341, D4342)
Description: Scaling and Root Planing falls under the Periodontics category of the patient’s insurance
plan. This treatment is performed on patients that have multiple gum pockets that are 4mm or greater or
have tartar under their gums as shown in their xrays. The patient is numbed and then the provider scales
subgingivally to remove built up plaque and debris. This will help the gum pockets shrink and reattach to
the tooth.
Visits: HYGIENE - Scaling and Root Planing - OP1 - Can be done in one visit, but most insurance carriers
pay for a maximum of two quadrants per visit. Providers usually the clean left side then the right side of the
mouth over two visits.

Periodontal Maintenance (D4910)
After a patient completes a HYGIENE - Scaling and Root Planing - OP1, they come back more frequently
to maintain the cleaned gum pockets to help ensure there’s no bacteria and food debris getting caught
below the gum line causing further infection. The provider will review the frequency of maintenance visits
with the patient, typically every 3 to 4 months. This more frequent cleaning visit is called HYGIENE - Perio
Maintenance - OP1. Insurance carriers typically cover 2-4 of these visits during a benefit period.

Full and Partial Dentures (D5110, D5120, D5213, D5214)

Description: Dentures, full or partial, are tooth replacements that are removable from the patient's mouth.
Visits: Dentures are 5 visits requiring two weeks between the last 3 visits, or a total of 6 weeks to fabricate.

1. Primary Impressions - GP - Dentures (No Lab Case) - OP2 - A rough draft impression is taken of
the patient's mouth to create a custom tray that will be used to fabricate a custom tray to be used in
the secondary impression.

2. Secondary Impressions - GP - Dentures (2ndary Impressions) - OP2 - A fine detailed impression
taken using custom trays made from the primary impression from previous visit.

3. VDO/Wax Try In - GP - Dentures (Lab Case) - OP2 - Wax rims (record bases) are used to measure
the relationship between the upper and lower jaw.

4. Esthetic Try In - GP - Dentures (Lab Case) - OP2 - The patient approves the shape, size, color, and
position of teeth that are mounted in wax.

5. Delivery - GP - Dentures (Lab Case) - OP2 - The final full or partial denture is delivered to the
patient. Minor adjustments may be needed. Patients may need to be seen 3-4 times over the next
month for final adjustments.
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Bridge (D6740, D6245)

Description: Bridges of any type (traditional or implant-supported) are a tooth replacement procedure that
is permanently fixed in the mouth.
Visits: Require 2 visits to complete.

1. GP - Crown/Bridge Preparation - OP2 - Some of the enamel is removed from the teeth. The patient
leaves with temporary crowns or a bridge to cover the prepared teeth. The temporary might be
rougher than the final bridge or their natural tooth.

2. GP - Crown/Bridge Seat - OP2 - The lab created final bridge is permanently cemented on the tooth.

Implant (D6010)

Description: An implant is a tooth replacement. It is comprised of three parts, the implante, an abutment,
and a crown.
Visits: Requires 4 visits to complete.

1. Placement - GP - Implant Surgery (1 Implant) - OP1 - A titanium implant screw is surgically placed
in the patient’s jaw.

2. Uncover - GP - Implant Uncover - OP1 - The cover screw placed on the implant at the initial surgery
is replaced with a healing cap that allows the gum to heal properly around the implant.

3. Impression - GP - Implant Impression - OP1 - A coping is used to transfer the implant location to the
laboratory for final implant crown fabrication.
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4. Seat - GP - Implant Seat (Lab Case) - OP1 - The final implant crown is screwed into the implant. A
covering filling is placed over the screw access hole.

Scheduling
Proper scheduling allows maximum utilization of the office. Higher production and higher staff salaries can
be attributed to effective scheduling.

Appointment Types
Appointment types differentiate the procedure being performed in the clinic. Appointment types may also
be used to differentiate the clinical setup or flow. For example, two emergency appointment types exist, one
for new patients, and one for existing patients. This allows the doctor to differentiate their greeting and
dialogue depending on the patient status. Each Appointment Type has its own color. The standard naming
structure for appointment types is <<Provider Type>> <<Appointment Type>> <<Default Operatory>>. The
following is a list of all Appointment Types and their purposes.

▶Link to Scheduling Protocol Video

Appointment Type Purpose

GP - Clear Correct - OP2

GP - Dentures (No Lab Case) - OP2 Primary impressions

GP - Crown/Bridge Preparation - OP2 Preparation of crown or bridge

GP - Crown/Bridge Seat - OP2 Seating crown or bridge. Requires payment before
entry to the clinic.

GP - Delivery of Lab Case - OP2 Night guard delivery, sports guard delivery. Requires
lab case. Requires payment before entry to the
clinic.

GP - Dentures (2ndary Impressions) - OP2 Secondary impressions that requires a custom tray

GP - Dentures (Lab Case) - OP2 VDO, Esthetic try-in, delivery. Requires lab case.
Delivery requires payment before entry to the clinic.

GP - Emergency (Recall Patient) - OP2 Recall patient emergency

GP - Emergency (New Patient) - OP2 New patient emergency. Requires new patient
introduction. Requires new patient paperwork.

GP - Extraction (Multiple) - OP1 Extraction of multiple teeth

GP - Extraction (Single) - OP1 Extraction of single tooth

GP - Fillings - OP1 Fillings

GP - Implant Impression - OP1 Impression for implant crown

GP - Implant Seat (Lab Case) - OP1 Seating of implant crown. Requires lab case.

GP - Implant Surgery (1 Implant) - OP1 Implant placement surgery

GP - Implant Uncover - OP1 Implant uncover and place healing abutment

GP - Root Canal - OP1 Root canal

GP - Unspecified Appointment - OP3 Post operative check up, follow-up

GP - Zoom Whitening - OP3 Zoom whitening
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HYGIENE - NP to Hygiene (Adult) - OP1 Comprehensive exam for adults after an
emergency. Requires only the bitewings and no new
patient introduction. No new patient paperwork
required.

HYGIENE - NP w/ Prophy (Adult) - OP1 Comprehensive exam for new patients with potential
cleaning. Requires panoramic and bitewings and
new patient introduction. Requires new patient
paperwork.

HYGIENE - NP w/ Prophy (Child) - OP2 Comprehensive exam for new patient children under
the age of 12. May require panoramic xray and/or
bitewings. Requires new patient paperwork.

HYGIENE - Perio Maintenance - OP1 Periodontal maintenance after a scaling and root
planing (deep cleaning) appointment. Usually
occurs every 3-4 months.

HYGIENE - Prophy (Adult) - OP1 Recall cleaning for adults

HYGIENE - Prophy (Baby) - OP2 Recall cleaning for baby less than 3 years old

HYGIENE - Prophy (Child) - OP2 Recall cleaning for child 3 years and older and less
than insurance age for adult

HYGIENE - Scaling and Root Planing - OP1 Deep cleaning usually requiring local anesthesia

NOTES - Excused Absence Excused absence

NOTES - No Show No show

Block Block of time and to communicate important tasks
by day

Appointment Notes
Appointment notes are critical to retain important details about appointments. All appointment notes should
include the three letter initials of the person leaving the note. Appointment notes are used every time there
is communication between the office and the patient about the appointment, especially confirmation
statuses. The most recent note should be placed at the top of the appointment note. All appointment notes
are included on the routing sheet that may be seen by the patient, so it is imperative the notes be generic.
Providers may provide financial or clinical notes on the appointment note. Examples of appointment notes
may look like the following:

● Patient agrees to pay $400 at crown prep appt, will pay
remaining balance at seat JRS

● Patient wants shade A1 on tooth JRS
● 09/13/2022 Patient confirmed 2 day call CAW

● 10/15/2022 LVM for 4 week confirmation call CAW

● Doctor note about financial arrangements with initials.

● Doctor note about clinical requirements with initials.
● Front office note about 2 day confirmation with date and

initials.
● Front office note about 4 week confirmation date and initials.

OP3 Patients
Patients who no show 2 times or who have 4 excused absences within 6 months are considered OP3
patients. An alert is applied in the Edit Patient → Alerts → OP3 patient. The number of no shows and
excused absences can be found using the Locate button in OnSchedule → Past Appointments.
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OP3 patients’ appointments will have a white icon as shown in the following:

OP3 alert

Two consecutive attended appointments will remove a patient’s OP3 status.

OP4 Patients
Patients who are rude, demanding, drug seekers, or who create unnecessary stress among staff may be
designated by a provider as an OP4 patient. These patients are no longer contacted by the office. Any
patient sexual harassment concerns need to be alerted to the doctor immediately. These patients may be
designated OP4 and may also be dismissed from the practice. OP4 patients’ appointments will have a
warning icon as shown in the following:

OP4 alert

Dismissed Patients
Patients who threaten lawsuits, are belligerently rude, or have sexually harassed anyone in the office may
be formally dismissed from the office by providers. These patients are not allowed to schedule an
appointment and have been requested to find another dental office. Any scheduling requests by these
patients need to be alerted to the doctor. All communication with the patient needs to be with the doctor
only. Dismissed patients will have the following alert:

Dismissed Patient alert
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Moving and Rescheduling Patients
There are times that it may be necessary to move a currently appointed patient. It is imperative to do this in
such a way that it does not reflect poorly on the practice; regardless of the circumstance. The following are
examples of verbiage that can be used:

● “Our lab requested a couple of additional impressions to ensure we get the best result for your
case. When are you able to come in so we can get those taken?”

● “We had a slight scheduling conflict and were wondering if you were available to come in earlier (or
later) for your <Type of Appointment>?”

● “Our hygienist (or doctor) is running ahead of schedule today and can get you in at <Time> would
you be available to come in sooner?”

Appointment Types with Lab Cases
If scheduling a crown/bridge/denture/NG seat, ensure to attach the created lab case to the appointment.
This will make tracking the lab case easier when it arrives back from the lab by eliminating the need for
creating and assigning a case to an appointment.

Scheduling Rules
It is imperative to create a schedule that maximizes patient experience, efficiency, and office production.
Strict adherence to the following rules allows reduced stress on patients, staff, and providers.

● All appointments should be in 1 hour increments. Exceptions are the half hour appointment types of
HYGIENE - Prophy (Baby) - OP2, HYGIENE - Prophy (Child) - OP2, GP - Dentures (2ndary
Impressions) - OP2, GP - Crown/Bridge Seat - OP2, GP - Unspecified Appointment - OP3.

● If there is a need to extend appointments, extend appointments to 2 hours.
● Combination appointments such as fillings then extractions should be scheduled one right after

another to allow clinical staff to set up properly for both appointment types.
● OP1 and OP3 schedules begin on the 1/2 hour, OP2 starts on the hour to stagger patient care. It is

difficult for newer doctors to see three patients that show up at the same time. It is difficult for
hygienists to see two patients that show up at the same time.

● Adhere to operatory designations. OP1 Appointment Types need to be scheduled in OP1 or OP2.
OP2 Appointment Types need to be scheduled in OP2 or OP3. OP3 Appointment Types need to be
scheduled in OP3. OP3 patients should only be scheduled in OP3.

● Hygiene appointments need to coincide on appropriate doc OPs, schedule families side by side to
reduce family time in office.

● Overrides approved by doc for OP1 procedures in OP2. Assistants and fronts need to get provider
permission to schedule two root canals or HYGIENE - Scaling and Root Planing - OP1
appointments side by side.

● No blocks on schedule unless approved by the provider for that OP.
● Doctors share OP3 patients and the OP3 column. For larger offices, there may be one OP3 column

per provider.
● Doctors need to be able to see NP to Hygiene (Adult) and NP w/ Prophy (Adult), and may up or

down convert the appointment as needed.
Accelerated Hygiene

● Hygiene OP1 starts on the 1/2 hour
● Hygiene OP2 starts on the hour
● Hygienist writes concerns needing to be communicated to the doctor on the routing sheet. Hygiene

assistant communicates concerns and patient readiness, and charts for the doctor.

Filling Available Hygiene Appointments (Hygiene Too Slow)
One of the main functions of the Front Office is to keep the schedule full. Be vigilant in monitoring
schedules for openings that can be filled by new patient calls or emergencies. Reduce the amount of
unfillable (< 1 hour) gaps by moving patients sooner or later to adjacent appointments during the 2
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business day confirmation call. Gaps in the schedule can be filled using the following method in the
following order:

1. The Quick Fill List is a list used by very busy practices. Check with your doctor to see if your office
uses the Quick Fill List. When patients cancel an appointment, a note should be made in the
Quick Fill List when to call to reschedule. If they are not looking to reschedule, it is not necessary
to add them to the Quick Fill list. If a patient calls and requests a “Sooner If Possible” appointment,
it should be noted on the appointment, and that patient should be used to fill scheduling gaps. The
“Sooner if Possible” checkbox is found on the appointment schedule above the appointment type. It
is also accessible by right-clicking the appointment and selecting “Sooner if Possible” from the
appointment context menu.

2. New patient appointments are usually available at the same time every week. For example, if a
Tuesday morning appointment opens up, look at the following two weeks to see if a new patient is
scheduled at that same time. If so, call that patient and see if they want to come in a week earlier.
Use caution as regular prophy patients with insurance plans are typically scheduled 6 months from
their last cleaning. Only fill in gaps with patients that haven’t been to a regular dentist over 6 months
ago or patients on the discount plan to avoid billing cleanings too frequently.

3. Patients who missed appointments in the past might still want to be seen. These patients
appointments are found on the NOTES column under the Call to R/S Below block. Call these
patients and ask them if they would like to come.

4. The overdue hygiene list can be used to fill scheduling gaps in hygiene. Hygienists should be
reviewing the list for any potential no calls, such as out of benefits.

5. Emergency appointments can be seen by the hygienist. Many times the chief concern of the patient
can be addressed after the cleaning. Patients appreciate saving time by getting a cleaning and
addressing their chief complaint on their first visit.

Finding Available Hygiene Appointments (Hygiene Too Busy)
As the practice becomes busier it will be more difficult to find available hygiene slots for new patients
calling in and also for new patients to hygiene. The overriding emphasis is that all new patients wanting a
cleaning by the end of next week need to be seen by the practice. Use the following guidelines to ensure
hygiene is utilized efficiently.

1. Ensure all 4-week appointment calls are completed for hygiene patients and marked with the
correct confirmation status. Move people from the hygiene schedule if they do not intend to make
their appointment. Put notes with initials and a date stamp if the patient’s phone is disconnected or
you left a VM at the 4-week call. This creates a history if the patient is answering their phone.

2. Ensure all 2 business day calls are completed by 11 am for hygiene patients and marked with the
correct confirmation status. Put notes with initials and a date stamp if the patient’s phone is
disconnected or you left a VM. Clearing the schedule of inaccurate hygiene appointments early
allows the hygiene schedule to reflect who will really show up. It also enables open hygiene
appointments within 2 business days for new patients and new patients to hygiene.

3. Ensure all 1 business day calls are completed by 10 am for hygiene patients and marked with the
correct confirmation status. Ensure the language used with the patient via voicemail reflects the
urgency of their confirmation. Put notes with initials and a date stamp if the patient’s phone is
disconnected or you left a VM.
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4. Ensure all patients who no show for 2 appointments or consistently reschedule are accurately
designated as OP3 patients. Be consistent in designating those who call within 24 hours to
reschedule as no shows and potential OP3 patients upon the 2nd no show.

Once these protocols are being followed, use the following method in the following order to ensure patients
are able to be seen for a cleaning by the end of next week.

1. The doctor needs to be able to take prophylactic cleanings on their OP1 and/or OP2 schedule. All
Open and Affordable Dental doctors LOVE new patients. They will do anything in their power to
attract and retain new dental patients, especially doing cleanings.

2. All patients that are difficult cleanings need to be designated with a “Prefers Hygienist” alert that
shows on the appointment as a purple H. These patients should not be moved from the hygiene
operatory.

3. All OP3 patients should be moved to OP3 on the schedule.
4. All patients that have not responded to the 4 weeks, 2 business days, and 1 business day calls

most likely will not show up to their appointment. They may be moved to OP3 unless a provider
specifically indicates they do not answer their phone calls. This should be designated via a “Do Not
Contact” alert. Remember to tell the patient at their 1 business day voicemail that they, “need to
confirm their appointment or we may not be able to see them at their scheduled appointment time.”
If they do show up for their appointment, they should expect the possibility of having to wait.

5. All younger recall patients, especially females, under the age of 25 and especially children under
the age of 12 may be moved from hygiene to the doctor’s OP1 or OP2 as indicated in the
Appointment Type. These patients require the least amount of hand scaling and are easier cleaning
for the doctor.

6. Older patients, especially females over the age of 25 that show on their chart few dental
restorations or very few teeth (< 10) may be moved from hygiene to OP1.

7. Younger patients, especially females, under the age of 25 who are NP to Hygiene (Adult) (already
seen for emergency) may be moved from hygiene to the doctor’s OP1. These patients may require
less hand scaling.

8. If no hygiene availability is made using the above methods, new or recall patients may be
scheduled in OP1 and the doctor will perform the cleaning if necessary.

9. Families with children may be scheduled concurrently instead of sequentially. Scheduling families
on OP1-OP3 increases hygiene availability. This may require the doctor, assistants, and hygienist(s)
taking turns to xray, exam, scale, floss, polish, fluoride, and reschedule the patients. The hygienist
should be in charge of rescheduling the family. Right-clicking the appropriate appointment time and
selecting Schedule Family from the context menu helps facilitate family scheduling. This
multi-family member scheduling occurs infrequently. Multi-family scheduling is much appreciated by
patients.

Insurance
Open and Affordable Dental and Braces offices are in-network with almost all insurance plans. We accept
all PPO (Preferred Provider Organization), all Discount Plans, and most Medicare HMO plans. We offer our
own in-office discount plan for those who don’t have insurance.

Open and Affordable Discount Plan
The Open and Affordable Discount plan allows patients to receive discounted care. It can be purchased at
any time. It expires one year from the purchase date. It includes all exams and xrays and one simple
cleaning. For patients needing a deep cleaning, one maintenance cleaning is included. Children up to the
age of 26 are covered under family plans. The individual plan costs $200 and the family plan costs $300.
Families can upgrade from the individual plan by paying the additional $100 at any time. When someone
within the family purchases the family upgrade, the original purchase date is applied to all members of the
family. Because the cost of a cleaning, exam, and xrays is roughly the same price as the discount plan, any
patient who wants a cleaning will likely benefit from the Open and Affordable Discount Plan. Since
insurance carriers provide their own discounted fees to patients, it is not allowed nor necessary to use two
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discount fee schedules simultaneously. After a patient uses their entire insurance benefits for a year, they
simply pay the insurance carrier's discounted fees.

HMO/DMO Insurance Plans
Patients who have most HMO/DMO plans are required to be seen by specific offices that are in-network
with those plans. These plans pay a monthly check for an office to take care of all of their members and
reimburse procedures at greatly discounted rates. Open and Affordable Dental is not in-network with most
HMO/DMO plans. Use the following verbiage when asked if the office is in-network with an HMO/DMO
plan. “Your plan requires you to use certain doctors, and honestly there aren’t many doctors that take HMO
plans. As a courtesy to HMO members, we provide our Open and Affordable Discount Plan for your first
year at no charge. This is frankly better than your HMO plan as it includes all your exams and x-rays at no
cost for a year. The discount plan also gets you a free simple cleaning. If you do need any dental work it
will be discounted by 25%. During your first year, you may choose to apply for a PPO during open
enrollment or renew your discount plan when it expires.” This verbiage is also found on the FAQs
webpage.

Medicare Plans
Most Medicare plans fall into one of three categories:

1. Medical Only Plans. Some patients have not elected to purchase the dental portion of Medicare
coverage. These patients have a Medical Only Plan. These patients may be offered the Open and
Affordable Discount Plan. See the following link.

2. PPO Plans - Patients who have selected a PPO dental coverage have their insurances applied like
employer driven PPO coverage. See the following link.

3. HMO/DMO Plans - When a patient presents with a Medicare insurance plan, it is not always
obvious what type of plan it is. Open and Affordable Dental is in-network for select HMO/DMO
plans. Offer to do a complimentary benefits check using the following scripting: “Medicare plans can
be tricky to determine whether we are in or out of network with them. I’d like to offer you a
complimentary benefits check prior to your visit to ensure that our providers are in network for your
particular plan. If we find that we are out of network for your plan we definitely have options for you
including a cost-effective in office discount plan that will help greatly reduce your out of pocket cost.”
Gather all information needed to verify the plan including ID numbers, group numbers, carrier name,
and customer service phone number(s) from the back of the benefit card. Contact the insurance
carrier customer service regarding the office’s network status.

Credentialing
Providers are considered in-network through a process called insurance credentialing. Contact the
credentialing specialist for all credentialing requests received via phone, email, or mail. When the Health
First Colorado enrollment is established for Medicaid, a letter will be sent to the office. Forward this letter to
doctors@openandaffordable.com. The credentialing specialist will set up the Health First Colorado account
for the office or provider and start the credentialing process with DentaQuest. It may take 45 days from the
time the office or provider is enrolled in Health First Colorado to get a DentaQuest account. Establishing
the DentaQuest account allows the office to be paid.

Insurance Verification Frequencies
Insurance is required to be verified according to the following protocols to prevent unknown lapses in
coverage.

● Medicaid is verified every calendar month. For example, if the patient is seen for the first time on
November 30th, they would need to be verified. If they were next seen on December 1st, they
would need to be reverified.

● Traditional insurance is verified at every new calendar year, as new plans are purchased by
employees/employers, AND is verified every 6 months, whichever is sooner.

24

https://www.openandaffordable.com/frequently-asked-questions
mailto:doctors@openandaffordable.com


Unfamiliar Insurance Carriers
Patients may present with an unfamiliar insurance carrier. It is important to find the office’s in-network
status for the carrier and plan. It is likely they found the office as an in-network provider through their
insurance company. Sometimes insurance companies subcontract other insurance companies to provide
dental benefits. The following steps are used to discover the patient’s insurance carrier.

1. Contact the insurance carrier listed on their insurance card. If the patient doesn't have a card,
perform a Google search to find the insurance carrier’s website and contact information.

2. Upon locating either a customer or provider service number, ask for the following information:
a. Are we considered an “in-network” provider?

i. If so, what fee schedule do they follow (do they follow another carrier's fee schedule
like Delta, Cigna, Dentemax, etc…) or do they have their own? If they have their own
fee schedule, ask them to fax or email a copy of that fee schedule to the office.

ii. If not, how can we join their network?
b. Are they a discount plan (is the patient responsible for all charges) or a traditional insurance

plan (will they pay a percentage of the services)?
c. Do they accept electronic claims? If so, what is their electronic payor id?
d. Do they accept electronic attachments? If so, what is the NEA payor id?
e. What is their mailing address and provider service number?

Once the above information is gathered, enter the new Insurance Company into Eaglesoft → Practice
Management → Lists → Insurance Companies. Employers can now be configured using this new
insurance carrier.

Insurance Verification Before Admission to Clinic
Patients are not allowed to be admitted to the clinic until their insurance is verified and loaded into the Edit
Patient window. Admitting patients to the clinic without fully verifying benefits causes treatment plans to be
inaccurate, leading to both provider and patient confusion. The following three exceptions may be allowed:

● If the patient is a long term patient and they switched insurances and they accidentally showed up
without their new information.

● If the patient presents in pain and insurance cannot be verified.
● If the patient presents with insurance that is unable to be contacted because they are outside of

business hours. This occurs mostly on days where Open and Affordable Dental is open but the
insurance company is not, such as Saturdays and on insurance observed holidays.

The patient should be advised they may have a charge for the procedure until we can verify their insurance
eligibility. If their insurance is verified post co-payment, we may issue a reimbursement for charges beyond
their patient portion. Communicate the progress of insurance verification to patients often while they are in
the waiting area.

Verifying Insurance
It is imperative that all patients admitted to the clinic have their insurance verified in a timely manner.
Failure to verify insurance in a timely manner disrupts the office efficiency and flow. The insurance
verification process begins at the new patient call or walk-in. A patient’s phone number, DOB, SSN,
address, and corresponding subscriber information is requested. If a patient is reluctant to provide any of
this information, they can provide that information by arriving at their appointment 30 minutes early. If a
patient is reluctant to provide their SSN to Open and Affordable Dental and Braces, they may pay our
standard fees and work with their insurance company to receive a claim payment. We can provide them
with a detailed report of all procedures performed with corresponding documentation including x-rays or
periodontal charting. Verifying insurance includes ensuring the downloaded/faxed benefit information
matches the Edit Patient/Employer window. A daily schedule is printed 3 days prior to each day’s
appointments. This daily schedule will be used to verify each patient for completeness. Notes on the
patient's appointment will be used to request missing information either immediately, during the 2-day prior
appointment call, or when the patient arrives.
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Policy Holder Member ID Numbers (Subscriber ID Numbers)
Some insurance carriers require Policy Holder Member ID Numbers (Subscriber ID or Privacy ID) Numbers
instead of Social Security Numbers on claim submissions. The following are carriers that require Policy
Holder Member ID Numbers:

● Aetna - Usually starts with a “W”
● Anthem - The medical ID will have 3 leading letters, then 3 numbers, a letter, 5 additional numbers.

You can drop the leading 3 letters to get the dental plan ID number; such as “XSB930M93499”
becomes “930M93499”

● Cigna - Usually starts with a “U”
● Companion Life
● Delta CO
● Delta Dental of WI (Wisconsin) ← ALL Individual Plans Regardless of State of Residence
● Kaiser plans (through Delta Dental) - require Kaiser Health Record ID number
● Colorado Medicaid - Starts with a letter followed by 6 numbers
● Principal - Usually starts with “90”
● UHC (Employer specific)

If the plan provides a Policy Holder Member ID Numbers, it should be used as the patient’s primary
identification number. This is controlled at the Employer level on the Edit Employer window →
Preferences button.

The following information needs to be obtained for every patient by the 2-day prior appointment reminder
phone call:

● Name
● DOB
● Address
● Phone number
● SSN and/or Policy Holder Member ID Numbers
● Insurance Company - Noted in the Pref. Name field (in CAPS)
● Downloaded Insurance Benefit Information

The following information needs to be obtained, if available, for adult patients.
● Copy of insurance card
● Copy of government issued photo ID

Once insurance benefits have been downloaded and entered into the Eaglesoft Edit Employer window,
the name of the Insurance Company is written in ALL CAPS in the Pref. Name field in the Edit Patient
window.

● All patients without insurance are designated by “*CASH” until they purchase the Affordable
Discount plan where they will be designated with “DIS(I/F) <EXP DATE>”. DISF = Discount Family,
DISI = Discount Individual. Patients who show interest in purchasing the discount plan may be
designated by “*DIS(I/F)”. This communicates to providers that the patient has already received
information on the discount plan.

● Any person whose insurance is not verified will be designated with an asterisk e.g. “*AETNA”.
● Patients who are no longer active with their documented insurance plan will have “IE*<CARRIER>”

added to the insurance carrier name in the Pref. Name field and the insurance will be removed from
the Edit Patient window. Notes will also be made on the appointment to obtain new insurance
information during the confirmation process.

○ If there are outstanding claims for the patient, but they are no longer covered under the
carrier on the Edit Patient window it is possible to switch the insurance carrier for the
current DOS once the claim is generated over to the new insurance carrier. Keep in mind
however that treatment estimates will not be accurate. So it is best to only follow this method
when it is necessary to post a preventative or diagnostic visit that is covered at 100%. It will
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also cause the deductible and remaining maximum to be inaccurate once the new coverage
is officially entered.

The Memo within the Edit Patient window will be used to notate the following information:
● Last date of verification on DentaQuest website (for Medicaid patients)

○ Note should be made in the following format: “**Verified via DentaQuest MM/DD/YY,
<<ELIGIBILITY STATUS>>. Initials”

● Patient-level information: such as waiting periods and restrictive insurance plans.

● Plan specific information: such as missing tooth clauses.
Carrier Example of Missing Tooth Clause

Aetna

Cigna

Delta CO

Metlife

Required Benefit Breakdown Information
A complete benefit breakdown contains all information to build a plan in the Edit Employer window. The
downloaded benefit breakdown saved in SmartDocs needs to contain the following information:

1. Maximum and deductible amounts
2. Percentages of coverage by procedure categories
3. Downcode information

Fronts need to call and verify any missing portions of these items.

Fillable Benefit Breakdown Form
A fillable benefit breakdown form is found on the Open and Affordable Dental Office Access webpage.
Download the template PDF at this Link to the Documents folder. The template PDF will be saved as a
patient specific file with the entered information using the Print button on the bottom of the form. The saved
patient specific PDF will then be imported into the patient's SmartDoc. All patient specific PDFs need to be
permanently deleted from the workstation by the end of clinic week.

Locating Patient Benefit Breakdowns
Review the Verifying Insurance by Insurance Company in the Appendix for details regarding how and
where to obtain benefit information by carrier. Insurance website login pages are listed in the Insurance
folder in the chrome bookmark toolbar. Passwords are saved in Google Drive → Front Office →
Passwords. The benefit information is found in a different location and format for each insurance. It is
imperative the benefit breakdown is applied correctly for every patient. Not downloading and applying the
benefit breakdown costs the office patient chair time and causes financial confusion for the provider and
patient.
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Secondary Insurance - Coordination of Benefits
It is important to input dual insurances correctly to maximize patient’s benefits. Eaglesoft does not
accurately estimate Secondary Insurance co-payments. The Rem. Benefits field is entered as “0” for
secondary insurances to more accurately estimate patient copayments. Even if a patient has two of the
same insurances such as “DELTA CO/DELTA CO”, most insurances have non-duplicating benefits and will
not pay for the entire service as expected by many patients. The only exception to entering a “0” maximum
in the Secondary Insurance → Rem. Benefits field is with federal employee plans. These plans have a
medical Primary Insurance and the Secondary Insurance is their dental insurance. When the secondary
insurance payment is received with its potential patient credit, a check may be mailed to the patient for any
overpayment by the secondary insurance. Patients are requested to monitor their EOBs for these potential
overpayments.

● Patient is the primary subscriber for both plans:
○ Input the oldest insurance first. For example, if one plan started on 07/01/2014 and another

started on 01/01/2012 the 2012 plan would be the Primary Insurance and the 2014 plan
would be the Secondary Insurance.

● Patient is the primary subscriber on their plan and a dependant on a spouse’s plan:
○ The patient’s insurance plan is always the Primary Insurance and the spouse’s insurance is

always the Secondary Insurance.
● Patient is a dependant on two plans under the same parent/guardian:

○ The oldest insurance is the Primary Insurance. For example, if one plan started on
07/01/2014 and another started on 01/01/2012, the 2012 would be the Primary Insurance
and the 2014 would be the Secondary Insurance.

● Patient is a dependant on two plans under different parent/guardian:
○ The oldest insurance is usually the Primary Insurance. For example, if one plan started on

07/01/2014 and another started on 01/01/2012 the 2012 would be the Primary Insurance
and the 2014 would be the Secondary Insurance. In the rare instance that both plans have
started on the same date then the birthday rule typically applies. The parent/guardian whose
date of birth is first will be the Primary Insurance.

● Patient has traditional insurance and a Medicaid policy:
○ Traditional insurance is the Primary Insurance and Medicaid is the Secondary Insurance.

Specific federal laws dictate this requirement. Medicaid is the payor of last resort and
may/will pay the remaining balance. Any portion left unpaid after Medicaid has paid is the
patient’s responsibility.

● Patient has a medical policy with limited dental coverage and an additional dental plan (e.g. federal
employees):

○ The medical plan is the Primary Insurance. Typically this is the case with government plans
using Blue Cross Blue Shield medical plan. The medical plan pays for preventative and
diagnostic procedures, and their additional plan pays for anything else (and often a portion
of the preventative and diagnostic procedures).

■ The Secondary Insurance assumes the Primary Insurance (Blue Cross Blue
Shield medical plan) benefits and will reduce their payment. It is imperative to enter
the Primary Insurance to receive the entire payment.

● Patient has a traditional dental insurance and a dental discount plan (Open and Affordable Discount
Plan or a discount plan from another carrier):

○ Patients will receive a discounted fee schedule with their traditional dental insurance and
cannot combine these discounted fees with other discount plans including the Open and
Affordable Discount Plan. The Open and Affordable Discount plan is removed from the Edit
Patient → Preferences → Financial Preferences section.
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Entering Insurance Plans
After verifying a patient’s insurance, search for the employer to check if there is already a patient with the
same employer. From the Edit Patient window select the Employer link:

Type the name of the employer exactly as it is listed on the insurance verification into the Find: field. If
there is a match, compare the group number to the patient’s downloaded benefits.

1. If the group number is the same, review the Employer level Prompts window to check if the policy
has been recently reviewed or updated.

○ If the date listed is not within the last six months, verify the accuracy of deductibles,
maximums, and coverage amounts listed.

○ If the date is within the last 6 months, the group policy information is considered complete.
Select Okay → Okay → Use to apply the group policy to the current patient.

2. If the group number is not found or is different, enter a new employer with the new group number.
○ Select the New button from the Employers/Coverage List window:
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3. The following information is entered for every new plan:

○ The Name field will be entered exactly as it appears in the verified insurance breakdown.
This ensures duplicate Employers will be minimized. If the plan is an individual plan, it is
entered using the following naming standard: <<CARRIER>>: Individual Plan - <<Renewal
Month>>. For example if a plan is a Delta individual plan with a renewal month of February,
the name will be entered as “DELTA: Individual Plan - February”.

○ Fee Schedule field:
■ Aetna will use the Aetna fee schedule. If the Aetna plan is an indemnity plan, it uses

the Standard Fees fee schedule schedule.
■ Ameritas will use the Principal fee schedule.
■ ALL Delta plans will use the Delta of Colorado fee schedule regardless of the state

of origin.
■ Principal plans will use the Principal fee schedule.
■ United HealthCare uses the United HealthCare || DBP (Dental Benefit Provider) fee

schedule.
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If there is uncertainty about which fee schedule to use, ask the representative verifying the
insurance which fee schedule they use. If the representative is unable to provide the fee
schedule, they may transfer to Provider Services. Ask to verify the “Maximum Allowable
Charge” for a selection of procedures (e.g. D0140, D0274, and D1110). Compare it with fee
schedules using the Fee Schedule List window in Practice Management → Lists → Fee
Schedule List. Compare provided fees to the fees listed in the Allowable Fee column on
the Edit Fee Schedule window.

It may be appropriate to inspect other Employers who use the same Insurance Company to
see which fee schedule is applied.

Group Numbers
Group Numbers are typically broken down into a main group number and a subgroup number. Larger
companies use the main group number to specify the employer, and the subgroup number to specify the
level of employment such as hourly vs salary ro warehouse vs delivery driver. It is important to specify the
subgroup to eliminate confusion on plans. Subgroups within an employer may have completely different
benefit levels. It is appropriate to eliminate leading zeros when entering group numbers into EagleSoft. See
examples below:

Group Number From Benefit Breakdown Group Number Entered Into EagleSoft

00000011157-0000000001-0000000001 11157-0001

Coverage Books
Coverage books allow EagleSoft to account for exceptions to insurance plan norms. Some plans may
downgrade reimbursements for composite fillings to amalgam rates or porcelain or ceramic crowns to full
cast metal crowns. These situations are common for posterior teeth. Coverage books also accommodate
plans that break up individual services differently from the general Service Type. For example, an
insurance may pay 80% for Periodontics, but cover Periodontal Maintenance (D4910) at 100%. They
may also cover Preventive and Diagnostic at 100% but pay Panoramic Xrays (D0330) and Limited
Exams (D0140) at 80%. Some insurance coverages are entirely copay driven. Each of these situations
requires the use of a Coverage Book to ensure that treatment plan estimates and collections are as
accurate as possible. EagleSoft allows three methods of applying coverage cooks; Coverage, Co-Pay, and
Write Off. The Coverage and Co-Pay methods are the only methods used within Open and Affordable
Dental.
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Coverage Method
The Coverage method applies an exact coverage percentage to a specific service code. It is applied by
default when the Use Co-pay and the Use Write Off checkboxes are unchecked. The UCR specifies the
maximum fee the insurance carrier pays for the specific downcoded service code. For example, if a
composite filling has a negotiated fee of $100 and an amalgam filling has a negotiated fee of $60, the UCR
for Service Code “D2391'' would be entered as $60. Since amalgam and composite fillings are covered at
80%, the Coverage is “Percentage”, and the Covered is “80%”. The Ded. Applies column is used to
specify deductible usage for the service code. In this instance, assuming no deductible, the insurance
would pay 80% of $60 (Amalgam fee) = $48, and the patient copay would be $100 (Composite fee) - $48
(Insurance coverage) = $52.

Co-Pay Method
The Co-Pay method applies an exact copay to collect for each service code. It is applied by checking the
Use Co-pay checkbox. Select a service code from the Service column. The total fee is entered in the UCR
column. The copay is entered in the Co-pay column. All other fields are calculated by EagleSoft.

Coverage Book Naming Standards
Coverage books are named according to the following: <<CARRIER>>: <<TypeOfAdjustment>><<%>>.

<<Type of Adjustment>> <<Type of Adjustment>> Meaning How to List <<%>>

LIM Limited Exam Single percentage

OS Oral Surgery Basic/Major percentage

PRO Prosthetics/Dentures Single percentage

PM Perio Maintenance Single percentage

RST Restorative Basic/Major percentage

SLT Sealant Single percentage

PANO Panoramic xray Single percentage

Examples of coverage book names are included below.

Coverage Book Name Coverage Book Name Meaning

DELTA: RST100/50 Delta Fee Schedule, Restorative adjustments at 100/50 percent

DELTA: RST100/50 OS100/50 Delta Fee Schedule, Restorative adjustments at 100/50 percent,
OS adjustments at 100/50 percent

DELTA: RST80/50 PM100 SLT80 Delta Fee Schedule, Restorative adjustments at 80/50 percent,
Perio Maintenance and Sealant Adjustments at 80 percent

Using Existing Coverage Books
It is imperative to utilize existing coverage books if possible to reduce duplicates. This also makes it simpler
when fees are updated. Use the Search: field to lookup and apply the correct coverage book to the plan
you are updating/creating a new employer.

Creating a New Coverage Book
1. Select the Coverage Book link within the Edit Employer window.
2. Select the New button at the bottom of the window.
3. Apply the correct naming convention e.g. <<CARRIER>>: <<TypeOfAdjustment>><<%>>

32



4. Check the Use Co-pay checkbox if the Copay Method is being used. Leave the Use Co-pay
checkbox unchecked if the Coverage Method is being used.

5. Select Add to add the dental codes being adjusted.

Coverage Down Codes
If resin-based composites are down coded to amalgam fees, enter the Service Code that is being down
coded (such as the posterior composite codes). The corresponding amalgam fee for the insurance carrier
is entered into the UCR column. Select “Percentage” in the Coverage column. Enter the appropriate
coverage percentage for the service code. The Ded. Applies column value is set to “Ignore” allowing the
Edit Employer window to control the deductible. Open and Affordable Dental assumes that all insurance
companies downcode posterior composites to amalgams unless otherwise stated. Here is an example of a
correctly entered coverage book using the Coverage Method:

Examples of Benefits Designating Down Codes
The following are examples of benefits designating composite down codes. This list is not comprehensive.
Other forms of phrasing may be used by various insurance companies. Codes that are commonly down
coded and grouped are D2391, D2392, D2393, D2394, and D2740.

Carrier Example of Composites Down Codes

Aetna

Cigna
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Delta CO

Metlife

Coverage Adjustments
If a service code is covered at a different percentage than its parent Service Type, the Coverage Method
will be used to specify the adjustment to the specific service code. For example, if Diagnostic Service
Types are covered at 100%, but a Panoramic Xray (D0330) is covered at 80%, select the “D0330'' code
from the Service column. Apply the appropriate fee for the D0330 into the UCR column. Change the
Coverage column value to “Percentage”. Enter “80%” in the Covered column and set the Ded. Applies
column to “Ignore”.

EPO/Copay Coverage Books
EPO plans are copay driven insurance plans. Insurance companies will provide a list of all service codes
and patient copays by service code. The Copay Method is used by checking the Use Co-pay checkbox.
Each service code provided by the insurance company is added to the Service column. The UCR column
is entered using the negotiated fee provided by the insurance company. The Co-pay is entered using the
copay provided in the benefit download. All other fields are calculated. A sample EPO plan coverage book
is shown below:

Saving Coverage Books
Save coverage books correctly, by selecting OK on the Edit Coverage Book window. Ensure the coverage
book is selected in the Coverage Book dropdown list on the Edit Employer window. Select OK on the Edit
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Employer Window. Ensure that all open windows are confirmed in the affirmative e.g. OK or Use, to ensure
no data is lost.

Discount Plans
Some insurance companies provide discount plans that simply dictate what providers charge patients.
These plans do not pay claims. The patient simply pays the fee dictated by their plan. Some discount plans
pay a monthly service fee to the provider for accepting the discount plan. This may be called the Patient
Access Fee. Discount plans configured in EagleSoft as an employer. For example, patients using the “Beta
19” discount plan are assigned the following employer:

The following are few of the discount plans accepted at Open and Affordable Dental:
● Aetna - Named “Aetna Dental Access”
● AmeriPlan
● Beta (All Plans) - Often referred to as “Alpha Dental”
● Careington - Named “Careington 500 Series”
● DDP - Named “Direct Dental Plans”
● DenteMax
● FiveStar Dental
● Patriot Dental

Even if the office is not In-network with a patient's discount plan, the office can immediately use the
patient’s discounted fees and become in-network with their discount plan at a later date.

Configuring Discount Plans
Since all fees are dictated by the fee schedule set the following values:

● Deductible and Maximum fields are entered as “.00”.
● The Fee Schedule dropdown is used to select the appropriate discount plan fee schedule.
● All Service Type Percent fields are set to “0” and Deductible Applies checkboxes are unselected.
● The Ins Form: field is set to “[None]”

Additionally check the Do Not Track Claims in the Edit Employer → Preferences window
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Appointment Confirmation
It is important to maximize office utilization. Confirming appointments reduces now shows and allows for
the front office to adjust the schedule to maximize office utilization. The four week confirmation
communication is utilized to adjust appointment dates and times for patients who scheduled their hygiene
appointment 6 months ago. Some offices optionally will have all appointments confirmed 4 weeks in
advance. Check with your office to see if they confirm all appointments at 4 weeks or only hygiene
appointments. All appointments are confirmed at the 2 business day call. Those not confirming at two days
are confirmed at the one business day.

▶Link to Confirmation Status Video

Confirmation Statuses
The following table is found on all Open and Affordable Dental computer backgrounds. It should be
consulted frequently. Along with Unconfirmed, these should be the only confirmation statuses used. It is
imperative the clinical and office staff set the confirmation status on every appointment they make.

The following is a more detailed confirmation status table.

Confirmation Status
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Greater than 4 weeks = Unconfirmed =

2 days or less = Confirmed = 4 weeks or less and greater than 2 days = Other =

2 days or less = Left Message = 4 weeks or less and greater than 2 days = Sent Email =

Confirmation Communication Timeframes
Consideration has been made to reduce text messages and phone calls to patients at inconvenient times.
Open and Affordable Dental sends automated text messages from 7:30 am to 7:30 pm at the
corresponding time the appointment is scheduled Monday through Sunday. For example text messages are
sent at 1:30 pm for all 1:30 pm scheduled appointments. Patients have the ability to opt out of future text
messages by texting “STOP” as a response to any confirmation text message. Both text messages and
phone calls initiated by the office staff should not start prior to 8:00 am unless for communication about
same-day 7:30 am appointments. Automated Oral Surgery callback request text messages start at 8:00
am.

Confirmation Timelines
It is important to understand the timeline of the confirmation communications. Open and Affordable Dental
uses Weave to obtain patient confirmation responses. All timeframes are prior to appointments. If offices
are not open some days, those days are not considered. For example, two business day appointment calls
should be made two office open business days before the appointment, which might be more than two
days in advance

1. 4 weeks - A Weave text message is sent to the patient requesting a “YES” response to confirm their
appointment. All “YES” responses are automatically switched via Weave to Confirmed in Eaglesoft.

2. 4 weeks minus one day - All Confirmed appointments are switched by front office staff to Other,
which is the Eaglesoft equivalent of “4 Week Confirmed”.

3. 4 weeks minus one day - All non-confirmed hygiene or optionally all appointments are called to
request confirmation. Any confirmed appointments are set to the Other confirmation status. Any
non-confirmed appointments are set to Sent Email, which is the EagleSoft equivalent of “4 Week
Non-Confirmed”. Appointment notes are made to log the communication. These calls are completed
before 12:00 pm.

4. 3 days - A Weave text message is sent to the patient requesting a “YES” response to confirm their
appointment. All “YES” responses are automatically switched via Weave to Confirmed in
EagleSoft.

5. 2 days - The front office calls all patients that are not set to Confirmed and requests an
appointment confirmation. Any confirmed appointments are set to the Confirmed confirmation
status. Any non-confirmed appointments are set to Left Message, which is the Eaglesoft equivalent
of “2 Day Non-Confirmed”. Appointment notes are made to log the communication. These calls are
completed before 11:00 am.

6. 1 day - The front office calls all patients that are not set to Confirmed and requests an appointment
confirmation. Any confirmed appointments are set to the Confirmed confirmation status. Any
non-confirmed appointments are set to Left Message, which is the Eaglesoft equivalent of “1 Day
Non-Confirmed”. Appointment notes are made to log the communication. These calls are completed
before 10:00 am.

7. Clinical staff inspect confirmation status and confirmation log appointment notes during the morning
huddle to adjust schedules and optionally drag off appointments for patients who have not
confirmed.

8. All clinical staff are correctly setting confirmation statuses to Other for patients scheduled greater
than two days and less than 4 weeks, and Confirmed for patients scheduled 2 days or less. This
eliminates duplicate confirmations.
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If a patient shows to a scheduled appointment that was never confirmed and all confirmation protocols
were followed, the following verbiage is used:

“It looks like we attempted to reach you several times to confirm this appointment, do we have the
best contact number and email address for you? Did you receive those messages?”

1 Business Day Confirmation Protocol
All patients not confirmed by the 2-day prior communications will be verified by a phone call, voice mail, or
text message. 1 business day confirmation communications need to be completed by 10 am. This allows
canceled appointment time slots to be filled. Office closed days are disregarded. The appropriate
confirmation will be designated on each appointment note.

1 Business Day Confirmation Verbiage
Phone call:

Hello, may I please speak with <<Patient’s Name>>? This is <<Your Name>> with Open and
Affordable Dental. I am just calling to confirm your dental appointment for this coming <<Day
of Week>>, at <<Appt Time>> am/pm. Are we able to confirm your appointment? Ok, great!
Thank you so much <<Patient’s Name>>, we look forward to seeing you!

Voice Mail:
Hello, this message is for <<Patient’s Name>>. This is <<Your Name>> with Open and
Affordable Dental. I am just calling to confirm your dental appointment for this coming <<Day
of Week>>, at <<Appt Time>> am/pm. We need you to call us at <<Your Office’s Phone
Number>> for you to be seen at your appointment time. Thank you <<Patient’s Name>>, we
look forward to seeing you!

1 Business Day Confirmation Appointment Note
Since the confirmation statuses have already been changed to Left Message at the 2 business day
confirmation call, type a note on the appointment letting others know of the second attempt as follows:

“<<MM/DD>> - LM at 1 day cnfm call. <<Your Initials>>”
Other non-confirmed appointment notes may be used. The confirmation status will still be set to “Left
Message”.

“<<MM/DD>> - Unable to LM at 1-day cnfm call, VM full. <<Your Initials>>”
“<<MM/DD>> - Phone number D/C at 1 day cnfm call. <<Your Initials>>”
“<<MM/DD>> - No contact information available at 1 day cnfm call. <<Your Initials>>”

It is most efficient to type your first confirmation appointment note, copy it to your clipboard (Ctrl+C) then
paste the text (Ctrl+V) to all appointment notes with the same status.

2 Business Days Confirmation Protocol
All patients not confirming via the 3 day confirmation text will be contacted at 2 business days prior to their
appointment. All patients will be verified by 11 am either by text, email, or phone call. It is imperative to
transfer all information on the New Patient Form to the Edit Patient window including primary, secondary
phone numbers, and email before contacting the patient. Ensure that you are reviewing any and all notes
on the appointments to see if there is any additional information needed to verify insurance or
communications that need to happen prior to the patient’s visit. The appropriate confirmation status for the
2 day call is either Confirmed or Left Message. There should be no other status used. Additional
information including disconnected phones will be noted in the appointment note with the corresponding
initials of the person writing the appointment note. See examples below.

2 Business Day Confirmation Verbiage
Phone call:

Hello, may I please speak with <<Patient’s Name>>? This is <<Your Name>> with Open and
Affordable Dental. I am just calling to confirm your dental appointment for this coming <<Day
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of Week>>, at <<Appt Time>> am/pm. Are we able to confirm your appointment? Ok, great!
Thank you so much <<Patient’s Name>>, we look forward to seeing you!

Voice Mail:
Hello, this message is for <<Patient’s Name>>. This is <<Your Name>> with Open and
Affordable Dental. I am just calling to confirm your dental appointment for this coming <<Day
of Week>>, at <<Appt Time>> am/pm. Please call us at <<Your Office’s Phone Number>> to
confirm your appointment. Thank you <<Patient’s Name>>, we look forward to seeing you!

2 Business Day Confirmation Appointment Note
Type a note on the appointment letting others know of the confirmation communication as follows:

“<<MM/DD>> - LM at 2 day cnfm call. <<Your Initials>>”
Other non-confirmed appointment notes may be used. The confirmation status will still be set to “Left
Message”.

“<<MM/DD>> - Unable to LM at 2 day cnfm call, VM full. <<Your Initials>>”
“<<MM/DD>> - Phone number D/C at 2 day cnfm call. <<Your Initials>>”
“<<MM/DD>> - No contact information available at 2 day cnfm call. <<Your Initials>>”

It is most efficient to type your first confirmation appointment note, copy it to your clipboard (Ctrl+C) then
paste the text (Ctrl+V) to all appointment notes with the same status.

4 Week Confirmation Protocol
A confirmation status of Confirmed at 4 weeks prior designates the patient has confirmed through the
automated confirmation system. Change the Confirmed status to Other so the patient will receive another
confirmation text via the automated confirmation system 3 days prior to their appointment. All
non-confirmed appointments will need to be contacted. A phone call, text, or email will be made by 4 weeks
minus one day for next month’s hygiene appointments. Some offices require confirmation of all
appointments at 4 weeks. Discuss with your doctor if your office requires 4 week confirmations for all
appointments. If the patient is able to be confirmed, their confirmation status will be set to Other. If a
voicemail or text message is left, with no reply, use the confirmation status of Sent Email.

If appointments open up on the hygiene schedule, it may be appropriate to move cleanings from the
doctor’s schedule to the newly opened hygiene schedule. Ensure patients with multiple appointments or
those with families are moved together as appropriate.

4 Week Confirmation Verbiage
Phone Call:

This is <<Your Name>> from Open and Affordable Dental. I am making a quick reminder call
for your cleaning appointment with us on <<Appointment Date/Time>>. Does that day and
time still work well for you? We will call you two days prior to your appointment date to
confirm your appointment. Thank you!

Text message:
-----, you have a dental appointment scheduled at Open and Affordable Dental on ----- at
-----. If that date does not work, please call our office to reschedule. We will send you an
additional reminder closer to your appointment date.
Open and Affordable Dental
<Your Office Phone Number>

If the patient does not answer their phone or text, the following message will be left via voicemail.
“This is <<Your Name>> with Open and Affordable Dental. I am just giving you a courtesy
call to remind you of your appointment on <<Appointment Date/Time>>. If for any reason
this date or time doesn’t work please call us at <<Your Office’s Phone Number>> and we
can discuss some other scheduling options. Otherwise, we will be calling you 2 days before
to confirm. Thanks <<Patient’s Name>>, and we look forward to seeing you next month!”
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4 Week Confirmation Appointment Note
Type a note on the appointment letting others know of the confirmation communication as follows:

“<<MM/DD>> - LM at 4 week cnfm call. <<Your Initials>>”
Other non-confirmed appointment notes may be used. The confirmation status will still be set to “Left
Message”.

“<<MM/DD>> - Unable to LM at 4 week cnfm call, VM full. <<Your Initials>>”
“<<MM/DD>> - Phone number D/C at 4 week cnfm call. <<Your Initials>>”
“<<MM/DD>> - No contact information available at 4 week cnfm call. <<Your Initials>>”

It is most efficient to type your first confirmation appointment note, copy it to your clipboard (Ctrl+C) then
paste the text (Ctrl+V) to all appointment notes with the same status.

Patient Check In
Patients are to be greeted as soon as they arrive. If two patients arrive at the same time, the second patient
may be asked to be seated for a few moments until the first patient is assisted. Common greeting phrases
are:

● Not recognized person: Thanks for coming in, how may I help you?
● Recognized person: Hi <<Patient’s Name>>, it’s nice to see you, have a seat and we’ll be

with you in a few minutes.

Patients Without Appointments
Patients occasionally arrive without a scheduled appointment. It is important to understand the protocol
around each scenario. Computer and communication malfunctions may occur causing the patient to be
contacted about an appointment that does not exist. These same malfunctions may remove appointments
that patients are expecting. It is important to adhere to the following protocol to reduce patient frustration.

New Patient Walk-In
It is the Open and Affordable Dental’s policy to accept patients on a walk-in basis, especially those in pain.
Patients may find this on the Open and Affordable Dental website or the patient may be sent by Answering
Service. If the patient is new and a walk-in, the new patient paperwork is given to the patient, and the
patient will be seen by the doctor or hygienist, whoever is most available and depending on Appointment
Type. Ask the clinic staff for the approximate wait time and alert the walk in patients of their expected wait
time.

Wrong Appointment Date/Time
Communication malfunctions may cause patients to receive appointment reminders for the wrong
date/time. If a patient presents for an appointment with a date/time different from the Eaglesoft scheduled
date/time, search for the miscommunication in the Weave app → Messages → <<Patient Name>>. Email
a screenshot of the Weave miscommunication and the EagleSoft appointment to
corporate@openandaffordalble.com. If the patient informs the front of an appointment that is found on
another day, discuss with the patient the status of the appointment and if they want to be seen at the
Eaglesoft scheduled date/time or if the patient prefers to be seen now. If the appointment is a longer
procedure and it is the patient's mistake, it may be appropriate to see the patient at their originally
scheduled appointment time.

Existing Patient No Appointment
If a patient arrives and reports they are scheduled for an appointment, but no appointment is located for
that day visually, use the Locate button at the top of OnSchedule to find them using the Search: field. For
example, find Jane Doe by typing simply “Do,J”, to find anyone with a last name that starts with “Do”, and
first name that starts with “J”. You may courteously ask them for the spelling of their last name. If no
appointment is found, it is possible that there was an error when originally scheduling the patient. Do not
tell the patient you don’t see them on the schedule. Schedule the appointment as an GP - Unspecified
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Appointment - OP3 in any available operatory, and alert the assistant that the patient is a walk-in. The
assistant will ask the patient for the reason for the appointment.

Locate Button

Late Arrivals
Patients occasionally call when they are running late. This is an indication of a considerate patient, and
they may be notified we will see them when they arrive. When patients arrive late and the clinic is empty,
simply thank the patient for coming in, and continue with checking them in. If the clinic is busy and they
have arrived over 15 minutes late without prior communication, alert the clinical staff to see their availability
in seeing the late patient. If the clinical staff has substituted another patient for the late patient’s
appointment, ask the late patient if they are willing to wait, as another patient was seen in the clinic at the
previously appointed time. Open and Affordable Dental does not refuse patients who show up late, as all
late patients can be treated as walk-ins. Late patients may or may not be seen immediately depending on
clinical conditions.

No Shows
Patients who are late to their appointment receive a phone call 10 minutes after their appointment start
time. If the patient responds, they are told of their appointment time and may still be seen as clinical
schedules dictate. All no shows are moved to the NOTES column under the Call to R/S Below block.
Patients who have not shown twice will have the OP3 patient alert applied.

New Patient Forms
New Patient Forms can be found on the Open and Affordable Dental's website on the New Patient Forms
page. New Patient Forms are included in several languages for patient convenience. New Patient Forms
include demographic information, medical history and HIPAA, financial, and insurance consents. All
information received on the New Patient Form needs to be verified as complete and signed before
scanning into Eaglesoft SmartDocs.

Medical History
New Patients
The patient’s medical history is entered into EagleSoft using the Medical History button. It is required to
enter the medical history into Eaglesoft before the patient is admitted to the clinic. The medical history is
saved in Eaglesoft’s electronic Medical History and included in the New Patient Forms scanned into
Eaglesoft’s electronic depository SmartDocs.

Periodic Updates
When a patient’s contact or health information changes it may be necessary for them to complete an
updated New Patient Form.

Routing Sheets
Routing sheets are extremely important as they allow communication about everything concerning the
patient as they flow through the office. It is imperative they be used for each patient. All Appointment Notes
will be found at the bottom of the routing sheets. Routing sheets can be printed for the entire day by
selecting the Routing Sheets button in OnSchedule with no appointment selected. A single routing sheet
can be printed by selecting that appointment, then selecting the Routing Sheet button. After greeting and
identifying the patient, review the scheduled appointment in Eaglesoft to see if there is any additional
information to be gathered before the patient can be seen in the clinic (i.e. New Patient Forms, updates to
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insurance, etc…). After all necessary information is gathered, the routing sheet is placed in the appropriate
provider’s wall pocket in the clinic. Notify the proper clinical staff of the patient arrival and the Appointment
Type. The following scripting is to be used:

Patient Scheduled with Hygienist: “<<Hygienist Name>>, <<Patient Name>> is here for their
<<Appointment Type>>”
Patient Scheduled with Doctor (Notify Dental Assistant, NOT Doctor): “<<Assistant Name>>,
<<Patient Name>> is here for their <<Appointment Type>>”

Notify non-patient facing assistants of the patient's arrival. If all assistants are patient facing,
notify all assistants of the patient’s arrival. This will allow the first available assistant to
retrieve the routing sheet and begin the appointment.

In the event that the patient is an add-on to the schedule or arrived early for their scheduled
appointment the following examples are to be followed:

Add On: “<<Patient Name>>, is here for <<appointment type>>. They are aware there may
be a wait.”
Early Arrival: “<<Patient Name>>, is here for <<appointment type>>. They are aware that
they are early.”

Patient Check Out
All patients returning from the clinic will be directed by the provider to be checked out. The provider will
present the routing sheet and inform the front office if there is a patient balance and any other pertinent
check out instructions. If the provider expects to collect anything other than the EagleSoft patient balance, it
will be written on the routing sheet. If the provider simply states the patient has a balance, it is expected to
collect the entire Due Now balance shown in EagleSoft. Information from the routing sheets, the providers,
and assistants will be used to check the patient out. Scheduling the next appointment should be done
during the administration portion of the treatment in the operatory either by the provider or their assistant. It
is not the front office’s duty to schedule follow-up appointments. The front office personnel will work with the
provider to ensure the account is correct and ensure the patient is not over or undercharged. Patients may
partially pay for work that includes lab cases during preliminary appointments, but are required to pay in full
on the appointment date when the lab case is delivered.

Discuss Finances Alert
A Discuss Finances patient alert is assigned to any patient account with a verifiable patient balance. This
balance is discussed with the patient by a provider. Fronts will direct any account questions to providers
unless specifically directed to do so by providers. The Discuss Finances alert is removed when the patient
pays their account balance.

Discuss Finances alert

Collection Policy
The collection policy starts with accurate insurance benefits entered in by the Front Office. Accurate
insurance benefits get translated into accurate treatment plan fees. It is Open and Affordable Dental’s
policy to not send bills to patients. If Explanation of Benefits (EOB) is returned by an insurance company for
an amount different than what was initially given on the treatment plan, a phone call may be placed to the
patient explaining the difference, and an account statement with the EOB information attached can be sent
to the patient. No statements should ever be sent without a personal call from the front office or provider
explaining the reason for an account discrepancy. Patients are ultimately responsible for knowing their
insurance benefits. Treatment estimates are only estimates, and cannot be used against Open and
Affordable Dental to adjust patient copays. Signs are posted in all operatories explaining this policy. Open
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and Affordable Dental will be understanding when clerical errors on patient benefit information caused the
patient to initiate treatment. Clerical errors on deductibles, amalgam or crown downcoding, or unexpected
insurance discrepancies are to be minimized but should be collected from the patient. The following rules
minimize large patient balance.

● All treatment over $1,000 should be prepaid by the patient
● Patients should pre-pay for lab case deliveries before being released from front to clinic
● OP3 patients should pay for their treatment before initiation
● Recurring payment plans are only offered to patients of record for over a year
● Care Credit is offered to patients of record for under a year and can be used for any patient
● No starting implant restoration until surgery is completely paid off

Patients are required to pay for all treatment by the time the procedure is completed. For example, if the
fee for a root canal is $800, and a pulpotomy is initiated, a partial payment of the entire root canal can be
charged, but the entire $800 must be collected at the time the root canal is finished. For larger cases, it
may be appropriate to collect the patient portion before the appointment.

As routing sheets are printed for the following day, highlight patient balances on the Due Now line item
found at the top right corner of the routing sheet. Those accounts that need special attention or have past
balances will be reviewed with the staff at the morning huddle as this saves clinical time. Any accounts with
past balances or rejected claims will then be reviewed with the patient by providers and collected at the
appointment.

Processing Payments
All patient payments are processed from the Account Payment tab within the Account window in
Eaglesoft.

Credit Card Payments using XCharge (OpenEdge)
OpenEdge is the default payment processor for Open and Affordable Dental. OpenEdge uses a software
called XCharge to process credit card payments within Eaglesoft. To process a credit card payment:

1. Enter the Amount of the payment to be processed on the credit card.
2. Select the Save button on the lower right-hand side of the window. XCharge will send the payment

request to the patient facing card reader.
3. The patient is then requested to insert, tap, or slide their card as appropriate.
4. EagleSoft will print a credit card receipt from the printer selected in Printer Preferences within

Eaglesoft. The credit card receipt will include the patient account balance, which may be inaccurate.
The front will not provide the credit card receipt to the patient unless specifically requested by the
patient. The front may need to explain the balance on the credit card receipt does not always
accurately reflect the patient’s true balance.

Reprinting Receipts with XCharge
1. Login to XCharge using the appropriate credentials.
2. In the main window choose Lookup.

3. On the Transaction Lookup window select the transaction you are needing to reprint.
4. Choose Receipt at the top of the window.
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5. Select the appropriate type of receipt either Customer or Merchant from the pop-up.
6. Choose Print to print the transaction.

Changing Processed Credit Card Transactions Information with XCharge
If you erroneously enter a credit card payment and want to change the details of the payment without
affecting the actual Xcharge transaction, simply find a workstation that doesn't have an Xcharge terminal
installed and modify the payment from within the Account window. This may occur if you are accidentally
logged into a wrong day in EagleSoft.

Credit Card Payments using CardPointe
CardPointe is Open and Affordable Dental’s backup, future payment, and recurring payment credit card
processor. CardPointe allows for single or recurring payments. If your office does not use Corporate
Accounts Receivable, payments processed using CardPointe should be entered into EagleSoft as a
Payment Plan payment type. CardPointe might be used when an office is first opened or if Xcharge is
unavailable. The following steps outline taking single payments through CardPointe.

Single Payment with CardPointe
Single payments can be entered using CardPointe. This normally occurs when the XCharge is unavailable.

1. Navigate to the CardPointe website and select Login
2. Obtain the credentials from the office’s password Google doc.
3. Select Virtual Terminal
4. Enter in the credit card information into the following window.
5. Enter the payment amount into EagleSoft Account->Account Payment window selecting

Payment Plan as the Payment Type.
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Recurring or Future Payment Plan with CardPointe
Recurring or future payments may be set up using CardPointe. Ensure all payment plans are following the
Collection Policy guidelines.

1. Navigate to the CardPointe website and select Login.
2. Obtain the credentials from the office’s password Google doc.
3. Select Virtual Terminal.
4. Select Billing Plans→New Billing Plan.
5. Enter in the credit card information into the following window.
6. Select Email Receipt to alert the patient of upcoming payments.
7. Enter in payment details for the billing plan including start dates, amounts, and frequencies.
8. A single future transaction may be used for patients needing to be billed on their next pay day.
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CareCredit Payments
When processing a CareCredit payment you will need to follow the steps outlined below:

1. Select Login from the CareCredit website. Obtain the login credentials from the office’s password
Google doc.

2. Select New Transaction on the upper right.
3. Select Purchase from the Transaction Types.
4. Choose Submit a Purchase Transaction Now from the Purchase Method options.
5. Enter the account number from the patient’s card. If needed, look up the account information using

the Look Up Account tool to the right of the card number field.
6. Leave the The Card Is Not Present checkbox unchecked
7. Enter the Card Security Code and Exp Date (MM/YY)

a. If the card does not have an expiration date, check the This Card Has No Expiration Date
checkbox

8. Enter the Amount
9. Select CareCredit from the Program Name dropdown menu
10. Choose 106 6 Month Deferred/No Interest if Paid in Full from the Tran/Promo Code picklist.

a. Note: This is the ONLY option available to patients. Any other option costs 15+% in financing
costs.

11. Select Submit
12. Enter the submitted amount in EagleSoft the Account Payment window using the Care Credit

option under the Payment Type dropdown.
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Cash Payments
Cash payments are not encouraged at Open and Affordable Dental. Issues arise from counterfeit notes,
lack of petty cash, embezzlement, and handling non-hygienic notes. When exact change is not available,
the patient may overpay with cash and leave a credit on their account. An Account Note is created when
an overpayment is made.

1. Select Cash as the Payment Type in the EagleSoft Account→Account Payment window.
2. Enter the Amount of the payment.
3. Select Save on the lower right-hand part of the window.

Check Payments
Patients may pay with current or post dated checks. Providers need to approve post dated checks.

Current-Dated
A current dated check is dated the same day it is presented.

1. Select Check as the Payment Type in the Account→Account Payment window.
2. Enter the Check Number.
3. Place the check with the financial transaction receipts to be included in the Deposit Report

With Itemized Cash at the end of the day.
Post-Dated
A post-dated check is dated for a day later than the day it is presented.

1. Select the appropriate Date for the check to be posted on the Account→Account Payment
window.

2. Enter the Check Number.
3. Place a sticky note on the check that it is a post dated check with the posting date in the

deposit envelope.
4. Include the check with the financial transactions to be included in the Deposit Report With

Itemized Cash on the post dated date.

Weave Payments
Payments can be requested through the Weave application for patients wanting to pay via text message.
Patient account statements can be attached to the text message if requested. Use the following protocol to
request patient payments via the Weave application.
Weave application → Payments → Search → <<Patient Name>> → <<Amount>> → Text to Pay →
Attach account statement in .PDF form (Optional) → Update Text Message (Optional) → Send

Printing Eaglesoft Receipts
Patients occasionally request receipts of their dental work to show to their Health Savings Account,
Accountant, or Insurance Company. Use the following steps to print receipts:

1. Open the Eaglesoft Account window for the patient.
2. Select the Report button on the right.
3. Select the range of dates desired using the Range: and To: fields.
4. Select the Preview Report button on the right.
5. If printing, select Print… from the File menu

a. Select the appropriate printer from the Printer name: dropdown menu.
b. Select the Print button at the bottom.

6. If saving the report to be emailed, select Export Document… from the File menu.
a. Select PDF File.
b. Deselect the Convert images to JPEG checkbox.
c. Select the OK button
d. Choose the desired save to location.
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Inbound Lab Cases
Lab tracking is essential to ensuring patients’ cases are present at the patients lab case delivery
appointment. Patients get frustrated when a lab case is not present when they arrive for their appointment,
especially if they received a confirmation call. Lab cases are created in the clinic and the patient is
scheduled to return at least one business day after it is returned. Since lab cases arrive by 11 am, it is
encouraged to schedule lab case delivery appointments in the afternoon. All lab cases should be inspected
as received before the 2 business days prior to the appointment confirmation call. Patients with GP -
Crown/Bridge Seat - OP2, GP - Delivery of Lab Case - OP2, GP - Dentures (Lab Case) - OP2, GP -
Implant Seat (Lab Case) - OP1 will have associated lab cases. Occasionally a patient will call in with a
broken temporary crown. It is appropriate to check if their lab case has been received and schedule them
for the GP - Crown/Bridge Seat - OP2.It is ultimately the doctor’s duty to ensure the lab cases are present
during the nightly and morning huddle. It is the front office duty to ensure all inbound lab cases are
accounted for in the following manner:

1. Open Onschedule.
2. Unselect all patients by clicking on any slot on the schedule without an appointment. Click on the

Lab Tracking icon above the schedule.
3. Uncheck Include Closed Cases. Uncheck Include Returned Cases. The remaining cases should

be only the overdue or cases still at the lab. Example:

2. Check Auto Search and search by patient name for cases in the system.
3. Right-click the patient's name and select Mark Case as Returned. This will place today’s date on

the Date Returned field for the case.
4. Go to the patient’s next appointment using the Locate button.
5. Lab cases may or may not already be assigned to an appointment. The Beaker icon on the

appointment designates a lab case is assigned to an appointment. An empty Beaker icon
designates a non-returned lab case. A full Beaker icon designates a returned lab case. When
processing inbound lab cases, there are three possible scenarios.

○ The lab case needs to be assigned to an Appointment.
■ Assign the returned lab case to an appointment by double clicking on the

Appointment and selecting the Lab Cases icon. Select the Lab Case just created
and click Apply on the bottom right of the window.

■ A full Beaker icon will display on the appointment - indicating that the case is in the
office.

○ The lab case is assigned to the Appointment, but needs to be set to Returned, changing
the Beaker status to full.
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■ Note the Beaker is half-filled on the appointment. Since the status has been set to
Returned, close then open OnSchedule to refresh the status. Note the Beaker
status of full.

○ The patient is not scheduled. Sometimes denture repairs are requested to be returned as
soon as possible, and the provider tells the patient they will be called as soon as the case is
returned. These cases might be returned as soon as 2 business days. The provider is
expecting the front to call the patient when the lab case is returned. Occasionally a provider
forgets to schedule a follow up appointment. This would also cause this same scenario.

■ Use the Locate button to find the next appointment. If it doesn’t exist, call the patient
to schedule the appropriate lab case delivery appointment. Once the lab case
delivery appointment is created, follow the above steps to assign the case to the
newly created appointment.

End Of Day Processes
XCharge End of Day

1. Login to the XCharge System using the appropriate credentials.
2. Select the Reports button

3. Select the Settlement tab

4. If reconciling for the same day, select the Load button. If reconciling a previous date, change the
dates in the date range fields to the appropriate date.

4. When the transaction information displays in the lower field, select Preview and compare the report
total with the Deposit Report With Itemized Cash from Eaglesoft.

5. If they match, select Print and add this report to the End of Day Packet.
6. If there are any discrepancies they must be resolved before continuing.
7. Once all credit card totals match, close the XCharge Reports window
8. From the main XCharge window, select Settlement
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9. Select Force to close out the current day’s batch.

Patient credit card deposits will show up in the bank account up to 2 business days later as “GLOBAL
PAYMENTS”.

End of Day Packet
1. View the following report: Practice Management → Reports → My Favorites → Deposit Report

With Itemized Cash.
2. Select Other Range Of Dates from the drop down menu. Do not use Today. Select the appropriate

date.
3. Preview the report.
4. Ensure all transactions listed on the report are matched to the corresponding cash, checks, credit

card settlement, and care credit receipts.
5. Make appropriate adjustments if needed until all subitems match the Deposit Report With Itemized

Cash.
6. Stamp all checks to be deposited with the Bank Deposit Stamp.
7. Fill out the bank deposit slip.
8. If the bank deposit slip does not have a carbon copy, make a copy of the completed bank deposit

slip to include with your End of Day Packet.
9. Stamp the front of the Deposit Report with Itemized Cash with the Total Summary Stamp stamp

and fill out the required fields.
10. Itemize the EFTs received individually below the stamp as shown. If there are multiple EFTs from

the same carrier they need to be listed individually as they fall into the bank account. Total all EFTs
to ensure the totals match the sum of the individual EFTs.

11. Highlight the Category Totals that correspond to the Deposit Totals stamp with the same color.
a. Deposit = Cash + Checks
b. Credit Cards
c. Care Credit
d. Payment Plans
e. EFTs

50



12. A deposit slip is included with all cash and stamped checks. This is deposited as soon as possible.
13. Discrepancies on the Deposit Report With Itemized Cash with individual items must be resolved

before the EOD process can be completed.
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14. The Deposit Report With Itemized Cash along with receipt from bank, carbon from deposit slip,
credit card settlement report, credit card receipts, Care Credit receipts, all EOBs, and EFTs (if
applicable) are stapled together and filed under the appropriate day in the monthly organizer. These
items need to be organized in the following packet per day:

Secondary Database End Of Day Packet (Optional)
If the office uses a secondary database, place a single Total Summary Stamp on the primary database’s
Deposit Report With Itemized Cash report, which will be placed on the front/top of the End of Day
Packet. Highlight each section's totals from both database’s Deposit Report With Itemized Cash as
shown in the above example. Assemble only one end of day packet.

End of Day Routing Sheets
Routing Sheets are printed nightly for the following day. Patient balances are highlighted on each Routing
Sheet and reviewed. Appropriate notes are made on the patient account and appointment to ensure
collections are made. Doctors and staff will review any accounts that are close to benefit maximums, have
complicated benefits, have outstanding balances or tasks.

Periodontal Charting
Periodontal charting is an important way to understand bone loss and inflammation around teeth.
Hygienists may request you help them chart these readings. They will read pocket depths to you. They
might also read recession or gingival margin readings. Select the appropriate patient and press the Perio
button. Simply type in the numbers as they are read to you. If periodontal charting is completed after teeth
are charted, Eaglesoft will mark the missing and/or impacted teeth in red and skip those teeth
automatically.

Periodontal Charting button
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Checking Email, Weave, ZocDoc, and WebChat
Various methods exist for patients to communicate electronically with the office. It is important to monitor
electronic communications frequently.

Email
Patients may schedule via the Open and Affordable Dental website. When a patient schedules via the
website, an email is sent to the info@openandaffordable.com email. This email account then forwards the
email to each individual office. All scheduled appointments received after hours, on Sunday, or during office
closed days are handled by the Open and Affordable Dental Answering Service. All scheduled
appointments received during office open business hours are handled by each office. In-office emails are
labeled in Gmail under !Patient-Communications. Emails are received from no-reply@powr.io. Fronts
and Answering Service call the patient to confirm the information provided. They also verify the insurance
and reschedule the appointment if necessary.

Weave
Patients may text the office or the Answering Service phone numbers. All text messages are received via
the Weave Application. The Weave Application is found on the Taskbar of all front office and answering
service computers. The Weave application may also be downloaded on cell phones and can be used to
answer calls when there is an Internet outage. Patients’ responses to confirmation texts are recorded in the
Weave application.

ZocDoc
Patients may schedule via the ZocDoc website. When a patient schedules via ZocDoc, an email is sent to
each individual office’s email. All scheduled appointments received via ZocDoc are handled by each office.
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In-office emails are labeled in Gmail under !Patient-Communications. Emails are received from
service@mail3.zocdoc.com. Offices need to block all OP3 operatories including holidays for days and
times the office is closed. This prevents patients from scheduling via ZocDoc on those dates and times.

WebChat
Patients may ask questions via the WebChat found at the lower right corner of the Open and Affordable
Dental website. The Open and Affordable Dental Answering Service is in charge of answering all WebChat
questions. Answering Service will consult the Frequently Asked Questions webpage for answers to
patients’ questions. Any question not found on the FAQs webpage will be emailed to
corporate@openandaffordable.com to be included in the FAQs.

Office Opening and Closing Procedures
Front office staff is in charge of locking and unlocking doors, turning on and off the lights, and turning the
office music on and off.

Doors
The front office will unlock doors at the office opening time. At closing time, it is the front offices’
responsibility to ensure that all doors are closed and locked prior to leaving the building.

Lights
Upon arrival in the morning, the front office staff will turn on the office lights and appropriate hallway and
entryway lights. Exterior lights should be turned on in the evening to ensure both the safety of patients and
the safety of Open and Affordable Dental and Braces staff members. Prior to leaving for the day the front
office staff will make sure that all lights are turned off prior to leaving the building. Some offices use robotic
vacuums that require light to function. Those offices will leave lights on during the evening.

Music
Prior to the first patient, the front office will turn on appropriate music for the day. Music stations must not
include inappropriate or suggestive language.

Processing Inbound Mail/Packages
The Front Office is responsible for checking and/or directing the inbound USPS, UPS, and FedEx
correspondence and packages. All correspondence is to be opened and separated into 5 categories:
Supplies, Invoices/Expenses, Payments, Zero-Pay EOBs/Research, Miscellaneous, or Junk.

● Supplies: Supplies are placed in the storage room and assistants are alerted of their arrival.
● Invoice/Expenses: Invoices and Expenses need to be reviewed by the doctor for payment

remittance. These items are placed in the doctor’s basket labeled Invoices/Expenses found in the
doctor's office.

● Payments: Explanation of Benefits (EOBs) may have check payments attached for payment of
insurance claims. These items are placed in the Checks folder and processed throughout the day.
As time permits during the day, EOBs and payments are entered into the patient’s account
according to the instructions provided in the Inbound Claim Payment Processing section of this
manual. Checks will be moved to the Bank Envelope and their attached EOBs will be moved from
the Checks folder to the Current Day’s Transactions folder.

● Zero-Pay EOBs/Research: EOBs not containing checks are included in this category. These EOBs
need to be researched for non-payment reason. Follow the process outlined in the Handling
Research/Narrative Requests or Handling Denials and Write-Offs sections in the manual.

● Miscellaneous: All correspondence from specialists is to be archived in SmartDoc. “SD,
<<Date>>” is written on the correspondence, then placed in the respective doctor’s Inbox found in
the doctor’s office.
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● Junk: Junk mail is discarded. They may include catalogs from suppliers, promotional offers, etc…
Best judgment is used to determine junk mail status. Doctors are consulted if there are questions
about correspondence’s junk mail status.

Access Other Office’s EagleSoft Using Splashtop
Occasionally patients call an office other than their home office. All Front Office and Answering Service
staff need to be well versed in using Splashtop to access another office’s EagleSoft patient management
system. All Open and Affordable Dental Splashtop computers are organized by office. It is important to
access only computers that have been designated as remote computers. The designation for a remote
computer is the character “#” after the computer name. Many remote computers are Virtual Machines.
Virtual Machines are hosted on machines designated by the character “@” after the computer name.
Occasionally the host needs to be accessed to turn on the Virtual Machine. A shortcut is included on the
Host’s TaskBar to turn on the Virtual Machine. Computers highlighted in Green are being accessed by
other users. Computers shown in Blue are online. Computers shown in Gray are offline. All Front Office
staff accessing another office’s EagleSoft will use the OA Scheduler user. The password will be provided
by the owner doctor. All Answering Service staff will access EagleSoft using the Answering Service user.
The password will be provided by the Answering Service manager.

Splashtop Computer Statuses
Online Computer

Offline Computer

Computer being accessed by user

Computer with “#” character, designating remote

Computer with “@” character, designating remote host

Transferring Patient Records Using Splashtop
Patient records can be transferred by saving documents on the remote computer’s Desktop. Splashtop’s
File Transfer button is then used to transfer the file between the remote and local computer. Alternatively,
you may drag files from the local machine to the remote machine and vice versa. After the file is transferred
to the local computer, the file may then be saved in the local computer’s EagleSoft patient management
system. It may be required to use the local computer’s Snipping Tool to capture remote information to be
saved on the local computer’s Desktop as a .JPEG file then imported into the local computer’s EagleSoft.

Call Forwarding
All offices are configured to have their calls forwarded to the Open and Affordable Answering Service after
3 unanswered rings. If an office needs the Answering Service to take calls during an office meeting or
because of staff shortages, the Answering Service is contacted as soon as possible to detail the forwarding
schedule. The Answering Service phone number is found at the bottom of the Open and Affordable Dental
website listed as After Hours: 720-580-1117. During office meetings, the office phones may be silenced.
During staffing shortages, it is appropriate to lower the phone volume to allow staff to answer phones when
available. Offices should not be adjusting Weave settings including office hours or forwarding information.
This causes issues in reconfiguring the Weave system to work properly after adjustments are made.
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SmartDoc Document Management
SmartDoc is Eaglesoft’s electronic document repository. The following documents are saved into the
patient’s SmartDoc archives:

SmartDoc Naming Standards

Document Type Proper Titling in SmartDoc

Consent Forms Dental Consent, Endo Consent, Ext Consent, etc…

Correspondence with specialists Endo Letter, OS Letter, etc…

Specialist referrals Endo Referral, OS Referral, etc…

Insurance documents Delta CO Elig, Principal Elig, Cigna Elig, etc…

Medication lists Rx List

New patient forms NPF

Scanning into SmartDoc
1. From EagleSoft, select the SmartDoc button.

SmartDoc button

2. Search for the patient in the Search: field
3. Select the appropriate patient by either double-clicking the patient or selecting the Use button.
4. Select the Scanner button shown below:

5. Ensure the Enable MultiPage box is checked near the top left if you are scanning documents from
the multi page feeder. Do not select Enable MultiPage if you are scanning ids, insurance cards, or
credit cards directly from the glass. Always select the Save Image as PDF Document check box at
the bottom right.
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6. Select the Get Preview button on the bottom left, then select the OK button on the next window to
begin document scanning.

7. Once the document scan has completed, all pages of your document will be displayed on the
right-hand side of the window. If you have additional pages to scan, select Scan to add more pages.
If no additional pages are necessary, select Get Images to load the document into the patient's
SmartDoc.

8. The document is now in the main SmartDoc window. Select the Disk button on the top left to save
and enter the proper title in the Document Name: field based on table above.
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9. Select the OK button to save the document.

Faxing Documents
Sending Faxes

1. Log into Weave desktop application.
2. Select the Fax button
3. Select the blue + icon at the bottom right corner of the app
4. Select the Click to Add link under Recipient(s)
5. Type in the phone number or name of the recipient in the Search/Enter Recipients field.
6. Check the Phone Number checkbox then select Add Recipient(s) button at the bottom.
7. Toggle the Include Cover Sheet toggle On or Off.
8. Include a Cover Sheet Memo if needed
9. Attach Documents if needed.
10. Select Next
11. Preview the fax using the Preview link if needed.
12. Select the Send button to send the fax.
13. Sent Faxes:

Resending Failed Faxes
1. Log into Weave desktop application.
2. Select the Fax button
3. Select the Sent tab
4. Select the Failed link to inspect the failed error
5. Select the Circled Arrow icon to resend the fax
6. If the fax number is incorrect, select the Fax → Forward, then forward to the correct number.

Delivered Faxes
1. Log into Weave desktop application.
2. Select the Fax button
3. Select the Sent tab
4. Select the Fax desired.

a. can be viewed anytime after being sent.

Received Faxes
Unread received faxes will have a notification icon on the Fax icon within Weave.

Weave Fax icon
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1. Select the Fax button then click on the appropriate new Fax.
2. Select the Preview/Print option to print the fax.
3. Select the Download option to download the fax
4. Select the Forward option to forward the fax.
5. Select the Mark Read option to remove the new fax notification.
6. Select the Archive option to archive the fax

a. Archive faxes can be retrieved by selecting the three dots at the top right of the Fax window.

Printing Work/School Excuses
Eaglesoft has standard work and school excuse letters. The following protocol is used to print these excuse
letters on office letterhead. Each printer has a label designating the proper page orientation to print on
letterhead.

1. From EagleSoft, open to the Edit Patient window
2. Select the Letter button on the right
3. Select School Excuse or Work Excuse from the Letter: dropdown menu.
4. The fields designated with << >> will be auto filled.
5. Make any changes necessary to the note, such as more days off or any other detail needed.
6. Check the Using Letter Head on Paper checkbox and uncheck the Include Header/Footer Info

checkbox.
7. Load letterhead paper in the printer.
8. Select the Process button.
9. A copy of the letter will be saved in the patient’s SmartDoc.

Printing Envelopes
Envelopes may be printed with either patient or insurance address.

Patient Envelopes
1. Ensure printer Tray 1 has been loaded correctly with envelopes.
2. From Eaglesoft, open to the Edit Patient window.
3. Select the Label/Env button on the right.
4. Select Print Envelope from the Method: dropdown list.

Insurance Envelopes
Insurance carriers occasionally request narratives.

1. Ensure printer Tray 1 has been loaded correctly with envelopes.
2. From Eaglesoft, open to the Practice Management window.
3. From the List menu, select Insurance Companies.
4. Select the insurance carrier from the Company Name field.
5. Select the Label/Env button on the right of the Edit Insurance Company window.
6. Select Print Envelope from the Method: dropdown list.

Returned Letters
There will be times when a welcome, transition letter, or other patient communication will be returned to us
by the USPS. Review the yellow label on the envelope and follow the steps applicable to the return outlined
below.
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New Forwarding Address Given

When a new forwarding address is given you will follow the steps below:
1. Pull up the patient’s Edit Patient window
2. Enter the new address into the <<Address>> field

3. Go to Patient Envelopes and follow the steps outlined to print a new envelope reflecting the new
address information.

4. Resend the letter that was returned to the new forwarding address.
5. Then go to the patient’s Account
6. Select Notes
7. Click the blue AutoNotes link

8. Scroll down to the OFFICE section and pick note “Transition Ltr R’tnd, w/Fw’d”

9. Pick your name from the office staff list, and click ok
10. The note will now be listed in the account screen as seen below:
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No Forwarding Address Given

When no forwarding address is given you will follow the steps below:
1. Pull up the patients Edit Patient window
2. Verify the address in Eaglesoft against the New Patient Forms, if available.

a. If it matches you will delete the street address out of the Edit Patient window and replace it
with the word “UPDATE”.

b. If it does not match you will update it to the address on the form and follow the steps above
to reprint the envelope with the updated address information.

3. Then go to the patients account
4. Select notes
5. Click the blue auto note link

6. Scroll down to the OFFICE section and pick note “Transition Ltr R’tnd, No Fw’d”

7. Pick your name from the office staff list, and click ok
8. The note will now be listed in the account screen as seen below:

Records Release
When records are requested by or for a patient, the attending doctor needs to be contacted to ensure
record completeness before records are released. It is important to have a records release form filled out

61



for records release requests to anyone other than the patient. The office specific Records Release Form
is found on the Open and Affordable Website → Office Access → Records Release → <<Office
Specific Release Form>>. Patient records include their xrays, odontogram, and chart notes.

Exporting Xrays
1. Select the View Images button within Onschedule.

View Images button

2. Select the appropriate patient using the Search: field.
3. Select each xray series from the left side of the Eaglesoft Advanced Imaging window.
4. From the File menu, select Export All.
5. Path to the Xrays folder, Export File → Quick Access → Xrays folder, and name the images

according to the following naming convention: <<Name of Patient>> <<Xray Type>> <<Date with
Hyphens>>. For example, “Jane Doe Pano 01-01-2017”.

6. Ensure to save the xrays as JPEG File Interchange (*.jpg) under the Save as type: dropdown.

Exporting Odontogram (Chart)
1. Select the Chart button within Onschedule.

Chart button

2. Select the appropriate patient using the Search: field.
3. Use the Snipping Tool to capture the Odontogram (Chart) from Eaglesoft.
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4. Save the odontogram as a .jpg to be included in the patient records. Snipping Tool → Save →
<<Patient Name>> <<Chart>>.

5. Ensure to save the chart as JPEG File Interchange (*.jpg) under the Save as type: dropdown.

Exporting Patient Notes
1. Select the Note History button within Onschedule.

Note History button

2. Select the appropriate patient using the Search: field.
3. Filter the appropriate notes using the Filter button with appropriate dates and options.
4. Select the Print button to open the Preview window.
5. Select Export Document…→ PDF File under the File menu.
6. Save the .pdf document to the appropriate folder.

Emailing Patient Records
Include all saved files in the outbound email. Include the patient name in the email subject.

Calling in Prescriptions to Pharmacy
Doctors occasionally instruct front office staff to call in prescriptions to the pharmacy. Only non-controlled
substances, those that don’t cause a physical or mental dependence, may be called into the pharmacy.
The prescription needs to be entered into EagleSoft before calling the pharmacy. The prescription
instructions are read directly to the pharmacy usually to their voicemail service.

1. Browse to the EagleSoft OnSchedule window
2. Select Prescriptions button
3. Select the appropriate patient if needed
4. Select the Rx Template: drop down item. Note: if you incorrectly select Drug: instead of Rx

Template:, it will not display the Rx Instructions:
5. Call the pharmacy and give them the following information:

a. Prescribing office and phone number
b. Prescribing doctor and DEA Number
c. Patient Full Name
d. Patient Date of Birth
e. Drug and concentration
f. How many to dispense
g. How many refills
h. Rx Instructions

6. Select Save or Print
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Ordering Office Supplies
It is the front offices’ responsibility to monitor and restock all office supplies. All large amounts need to be
approved by the doctor before making a purchase. Examples of items the front office is responsible for
monitoring include:

✓ Paper - Both RX and plain
✓ Printer Ink/Toner
✓ Ink Pens
✓ Sticky Notes
✓ Appointment Reminder Labels
✓ Paper Clips
✓ Hanging Files

✓ Stamps
✓ Folders
✓ Envelopes
✓ Clipboards
✓ Business Cards
✓ Office Pamphlets
✓ Batteries

Office supplies are typically ordered on Amazon. Within Amazon, hover over the List icon on the upper
right of the window near the cart. This will open the Reorder List menu. All supplies are listed in the New
Office Startup Document found on the Open and Affordable Dental Website → Owner Access → New
Office Startup Doc.

Social Media
The Front Office is responsible for assisting the doctors maintain the social media presence of their Open
and Affordable Dental and Braces location. This includes responding to messages, creating interactive
posts, and commenting on patient reviews.
There will be a minimum of one post per month and, at most, one per day (unless there is a special event).
Delayed/Scheduled posts can be made in advance. Examples of posts can include the following:

● “Throwback Thursday” style posts
● Contests
● Promotions currently being offered
● Happenings at the office
● End of year reminders to use benefits
● Holiday wishes
● Office closures
● Sharing of reviews from other platforms
…and more!

Patient reviews will also be responded to in a timely fashion with responses signed by the doctors of the
business. See examples below:

● Thank you so much for your excellent review, Levi! It's our pleasure to help wonderful patients like
you and your family!
Dr. Jason Stott & Dr. Anne Bielinski

● Thank you so much for your kind words, Kristen! We know your time is valuable and do our best to
maximize what time we get with you! Thank you again for the opportunity to help you with your
dental needs!
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Dr. Jason Stott & Dr. Anne Bielinski
● Thank you so much for your kind words, Izzy! We're glad you both had such a pleasant experience

at our office and look forward to taking care of your dental needs in the future!
Dr. Jason Stott & Dr. Anne Bielinski

● Thank you so much for taking the time to leave us such a kind review, Sasha! We love having the
opportunity to help your family with their dental needs!
Dr. Jason Stott & Dr. Anne Bielinski

In the event of an adverse review, the front office is to brainstorm the appropriate response with the doctor.
Taking into account the history the patient has with the practice and always keeping HIPAA policies in mind.
See the following example:

● We are sorry to hear that you feel that way, Rob. When a patient has insurance, the fees used for
their treatment are actually set by the insurance company, not our office. If for any reason you were
overcharged - we'd be happy to issue that back to you. Our Insurance Coordinator, Carly, would be
happy to review your account with you if you would like to discuss this further. Please reach out to
our office at 303-644-5058.
Dr. Jason Stott & Dr. Anne Bielinski

Daily Task List
The Daily Task List is found in the Appendix. The Daily Task List completed daily. As items are completed,
the front office signs their initials in each completion box. This will ensure accountability for the task’s
completion. If items are signed off, yet not completed, corrective action will be taken.

Weekly, Monthly and Annual Task Lists
Upon completion of the workweek, the Beginning of Week or End of Week crew execute the proper shift
change procedure. This includes completing all duties listed on the Weekly Task List found in the Appendix.
The doctor is required to review and sign off both the daily task list and the weekly task list before the shift
change. This ensures consistency between the Beginning of Week and End of Week staff. The monthly,
and annual task lists ensure that less frequently needed tasks are completed in a timely manner. It is
appropriate to put blocks on OnSchedule as reminders to complete the Weekly, Monthly, and Annual Task
lists. These tasks should be shared between Beginning of the Week and End of Week staff.

Accounts Receivable Functions

Outbound Claims Processing
The claims creation and reporting process in Eaglesoft is as follows:

1. The patient is created, the employer is setup with the accurate insurance company, fee schedule,
coverage book, coinsurance, coverage dates, deductible, and maximum. If a patient is purchasing
the Affordable Discount Plan, the discount is chosen on the Edit Patient → Preferences window.

2. The Edit Patient window is reviewed to ensure the accuracy of the insurance deductible and
maximum.

3. A treatment plan is created that applies accurate insurance information. If a treatment plan is
created before the correct insurance is applied, all proposed treatment must be changed back to
Existing, then back to Proposed to apply the correct insurance fee schedule, deductible, and
maximum.

4. Once the treatment plan is created, the treatment can be sent to the Walkout queue.
5. Providers should ensure all treatment completed is in the patient account before arriving at the front

office. All treatment can be walked out directly from the walkout tab within the Patient Account
screen, or selected from either the treatment plan or the walkout queue. Providers and assistants
should be very well versed in the ADA codes for all procedures. Ensuring all procedures are in the
account before the patient arrives at the front desk ensures the patient portion is collected at time of
service. Providers should also review with the patient account balances to ensure the patient knows
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what will be collected today and if there were any previous balances for the patient or their family. If
a service is to be collected at their next visit for a completed service e.g. crown seat, financial
arrangements can be made between provider and front or middle office.

6. The front office collects the entire or appropriate amount owed and applies it to the account via the
Account Payment Screen

7. All claims items sent to an insurance company should look like the following:

a. The line item will be blue. Any item in black means the claim is closed or hasn’t been sent.
b. The description will include 4 lines, the description, the standard fee, the adjustment, and

the insurance contracted fee.
c. Any item with a green dollar sign and red not signal hasn’t been paid.
d. Est Ins is the amount expected to be received by the insurance company
e. The amount is the amount contracted amount for the service.
f. The difference between Amount and Est Ins is the amount to be collected from the patient

8. From the Practice Management screen select “Claims” from the toolbar at the top of the screen.

9. The Process Insurance Claims window will open. Select BOTH Unsubmitted Claims and
Unsubmitted Elec to view all unsubmitted claims.

10. Sort the columns by Date Created. It is expected that all claims be processed within 3 business
days. The exception is if Xrays or necessary attachments are waiting to be processed.

11. Highlight the desired claim and select View Claim on the right (or use Alt-V on the keyboard).

12. The View Individual Insurance Claim screen will open. Review the services listed and verify if the
procedures need to have attachments (i.e. Xrays, perio charting, EOBs from primary carriers, etc.).
The following procedure codes should include preoperative x-rays to minimize insurance
processing’s need for additional information:
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a. Endodontics (D3310, D3320, D3330) - All preoperative x-rays showing pathology should be
included in the claim

b. Crowns (D2740, D2750) - All preoperative x-rays or clinical photos showing missing tooth
structure should be included. If a missing cusp does not show accurately on the x-ray, a
clinical photo should be added to the patient chart to be included with the claim.

c. Extractions greater than simple (D7210, D7220, D7230, D7240) - All preoperative x-rays
showing the tooth and possible pathology with its requirement for a more extensive
extraction should be included.

d. Scaling and Root Planing (SRP) (D4341, D4342) - Perio charting and all x-rays showing
bone loss.

e. Implants (D6010) - All postoperative x-rays showing the placement and possible pathology
should be included.

13. Upon reviewing the claim to determine the necessary attachments, close the individual claim
window and return to the Process Insurance Claims window. Select the checkmark at the beginning
of the claim.

**It is appropriate to focus first on the claims that do not need attachments then process
claims that need attachments. This allows batching of claims processing more efficiently.

14. For claims that require attachments, select the checkbox at the left of the claims and press the
Attachments button on the right side of the screen.
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Steps 15-24 Using EagleSoft Electronic Claims with Simple Attach
15. A separate program Simple Attach will open. Use the office-specific login credentials to gain

access. It is important to complete the entire attachment process from one computer even if there
are many computers in the office from which claims may be processed.

16. A queue with all the claims pending attachments will open.

16. Select the cloud with an arrow in the “Add Attachment” column to the right of the patient and carrier
name to begin the attachment process.

17. View the procedure code under the “Claim Details” portion of the window to determine the
recommended attachments for those codes. Select the Upload Attachment button.
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18. Ensure that you have the needed information (i.e. xray, perio charting, primary carrier eob, etc…)
for the claim pulled up in Eaglesoft on the same computer monitor that the Simple Attachment
software is open on.

19. Then select the “Capture Screen” button on the upper left of the following window to capture the
Eaglesoft information needed with the Simple Attach software.

20. After screenshotting the appropriate information, select the corresponding attachment type (such as
pano, perio charting, EOB, etc…) from the drop down under the Attachment Information section to
the left of the screenshot. Each captured item requires the Date Taken. Certain Xrays require noting
if it is the patient’s left or right side in the Xray. If you need to make an additional attachment, such
as an intraoral picture or periodontal charting, select the “Capture Screen” button and repeat the
previous steps to capture the additional information. Once you are done, select the “Upload File”
button at the top of the screen to save the item.

21. Once you select the “Upload File” button you will see the “Status” field update to reflect the
following:
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22. Then choose the “Close” button from the ribbon up top.

23. The “Claim Detail” screen will now show an “Attachment Preview” section reflecting the
attachment(s) you made for the patient’s claim. Select “Submit” on the bottom right of the window
and “Okay” on the subsequent pop-up window to send the attachment. This will then remove the
claim from the Simple Attachment work queue.

24. After closing the Simple Attach window, the Claims screen in Eaglesoft will update the Attachments
status from Incomplete to Complete for the particular attachment claims. Select the checkbox to the
left of the claim and press the Process button in the upper right.
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** In some instances the “Payor Name” field may be listed as “Unknown” in NEA. This means that the
particular insurance company does not accept electronic attachments for claims. So you will need to delete
the attachment from the NEA software, go back to Eaglesoft’s claims window, close and recreate the claim.
Upon recreation, you then change the Form Name to the most recent “Blank ADA ---” type. Then when you
process this claim it will print the claim form. You then mail to the insurance with the proper attachments
printed and enclosed in the letter. You would not want to change this on the edit employer screen because
claims that do not require attachments should/could be sent electronically. The following insurance carriers
do not accept electronic attachments:

● Aflac
● Carpenters and Millwrights
● Companion Life
● Freedom Life Insurance Company
● LineCo
● UMR

Recreating & Submitting Claims to be Mailed in Eaglesoft
To recreate a claim in Eaglesoft that needs to be printed and mailed with attachments, but is already
marked for electronic attachments you need to follow the steps outlined below:

1. Select the claim in question

2. Select the “View Claim” button to verify that the insurance carrier does not accept electronic
attachments.

3. Once you have confirmed this, you will go back to the “Process Insurance Claims” screen and
choose the button to “Close Claim.”

5. Select “Yes” on the window that pops up asking if you want to close the claim

6. Ensure that you select “Recreate claim” on the next screen that pops up regarding “Closing --
Insurance Claim.”
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7. Select “OK” on the next screen to recreate the claim.
8. Select “Yes” on the pop up asking if you’re sure you want to recreate the claim.
9. On the next screen entitled “Insurance Questions” you want to select “Print Now” under the Print

Claim section and then select “OK.” This will generate an ADA Form for your claim.

10. You will then want to print the appropriate attachments and mail the documents to the insurance
carrier.

Rejected Claims Reports (Using Change Healthcare)
When a claim is rejected it will show up in the claims window and

Inbound Claim Payment Processing
Open and Affordable Dental prefers to receive all claims electronically versus by check. This allows for
quicker availability of funds and reduces checks held at the office.
When payments are received, the EFT is printed or the EOB from the physical check is consulted. EFTs
are to be entered into EagleSoft the day the payment was received in the Open and Affordable Dental
business checking account. This means logging into Eaglesoft as the appropriate date for posting of the
EFT payments. This ensures that adjustments made as payments are processed are made on the same
business date as the payment. A new Deposit Report with Itemized Cash will need to be printed after the
EFT is entered. The explanation of benefit (EOB) information will be included on the Day Sheet which is
organized by day of the month in a file. At the end of the month, these Day Sheets are used for monthly
reconciliation, then finally packaged by day and month for future reference.
A typical claim payment includes the following information.

1. Subscriber Name
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2. Patient Name
3. Service Date
4. Submitted Amount = Standard Fee amount submitted from EagleSoft
5. Allowed Amount* = Contracted amount for an In-Network provider

*Allowed Amount may also be called the following: Maximum Allowable Charge, Negotiated Amount
6. Insurance Payment* = Amount insurance companies pay

*Insurance Payment may also be called the following: Plan Pays
7. Patient Responsibility* = Amount per the EOB the insurance calculates the patient should pay

*Patient Responsibility may also be called the following: Patient Owes, Patient Portion, or Patient
Copay.

There are 4 scenarios possible with a claim payment:
1. The claim payment amount matches exactly with what was estimated by Eaglesoft
2. The claim payment was rejected entirely

a. If the claim was rejected entirely, the rejection reason needs to be investigated. It may be
necessary for the front office to call the insurance company, have the doctor write a
narrative, or have the doctor write off the service amount. All rejected claims will be
delivered to the doctor’s rejected claims inbox.

3. The claim payment was lower than what was estimated by EagleSoft. The EOB from the insurance
company is the overriding authority on what the patient owes, regardless of what EagleSoft
estimated when the service was walked out. A simple formula can be used to calculate the accurate
totals.

● Insurance Allowed Amount - Insurance Payment = Insurance Patient Responsibility
● EagleSoft Amount - Eaglesoft Est Ins = Eaglesoft Estimated Patient Responsibility
● Insurance Patient Responsibility - Eaglesoft Estimated Patient Responsibility =

Eaglesoft Needed adjustment to patient balance.
a. Any difference in EagleSoft estimates vs Insurance claim should be mitigated by the front

office adjusting fee schedules, creating and applying coverage books, ensuring correct
deductibles and coverages, etc.

b. The following may be written off without doctor consultation with a $$$ account note
explaining the reason for the write off e.g. “$$$ Pano+BW->FMX <Initials>:

■ Panoramic x-ray and 4 bitewings (D0330 + D0274) to FMX (D0210)
■ Limited exams (D0140)
■ Xrays (D0274), (D0330), (D0220)
■ Sealants (D1351)

c. All rejected comprehensive oral exams (D0150) should be resubmitted as periodic exams
(D0120)

4. The claim payment was higher than what was estimated by EagleSoft.
a. If the claim payment was higher than what was estimated by Eaglesoft the EOB should be

followed to calculate the patient responsibility and also reduce the remaining insurance
benefits for the patient correctly

b. Open the patient's Account and click on the Insurance Payment tab. This window will show
all open claims for the patient. Verify you have selected the correct claim by looking at the
Date Submitted, Date of Service, Amount Submitted, and the Estimated Amount. Click on
the View Selected Claim button for more information about the individual claim.
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c. Enter the Payment Information for the check including the date, payment type, check
number, and the amount paid. You also have the option of marking this as the Final
Payment, print a payment receipt for your records, select how many copies to print as well
as change the printer that will print the receipts. Since this payment is an overpayment of the
amount estimated, you may wish to enter a Note in the Patient Note area. To enter a note,
simply click on the Note button in the lower right of the screen.

d. When an overpayment is entered, you should see a large, blue, round icon near the Total
Unassigned box. Hovering the cursor over the icon will show the message, "This amount is
not assigned to services associated with this claim". A smaller blue "i" icon will also appear
near the Save button to remind you about the distribution of the overpayment.
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e. After entering the payment (with the overpayment amount included), entered any pertinent
notes and distributed the amount received, click the Save button.

f. After clicking Save, you will see the Closing Primary Insurance Claim screen. If the patient
has Secondary Insurance, you will have the option of printing/submitting now, later or
electronically. Other choices include submitting the claim manually (meaning nothing will
print or go electronically, but the claim will appear as Open in the patient's claims) and close
the secondary claim. Typically you will select the option for “Submitting the Secondary Claim
Electronically” and immediately scan the primary insurance EOB into the patient’s Smart
Docs. After making your selection, click OK

g. If you choose to close the claim, you will see the second Closing Primary Insurance Claim
screen. This one has the Close Claim Options of Do Not Adjust the Account and Credit the
Account. In this scenario where the insurance has paid MORE than estimated, you would
not have a need for an adjustment to the account.

h. Other checkboxes at the bottom include Recreate Claim, Reduce Benefits by
Overpayment Amount, Update Annual Deductible for Patient and Assign Services to
Current Balance.

i. Keep the selection on the default Do No Adjust the Account and check to Reduce
Benefits by Overpayment Amount and click OK.
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Insurance Credit Card Processing
Some insurances remit their claims via electronic credit card. These cards will either be sent through the
mail or faxed to the office. This is not a preferred way of receiving insurance payments. The office is
charged a merchant services fee for each credit transaction run through xCharge. So to ensure that we are
maximizing the payment funds we should reach out to those carriers issuing the office this type of payment
and attempt to switch it to a more desirable method if possible.

For Insurance Credit Cards the Reflect just One Patient and/or DOS
If the card reflects just one date of service you may follow the steps below to apply that claim to the
patients account:

a. Pull up the corresponding patient Account.
b. Got to the Insurance Payment window.
c. Change your payment type to Insurance Credit Card.
d. Change the number of receipts to 1 and enter the payment information.
e. If you have a pin pad attached to your computer you will need to press the “Manual

Entry” button on the pin pad and type the credit card information on the pin pad.
f. Once the card processes, you will see the approved message on EagleSoft.

For Insurance Credit Cards that Reflect Multiple Patients and/or DOS
If the card reflects either multiple patients or multiple dates of service you will need to process this
in xCharge separately and then apply it to each of the patients. This is because the virtual cards
that we are sent from insurance typically only allow us to run one transaction on the card.

a. Log directly into xCharge.
b. Enter the insurance credit card information into the main screen.
c. If you have a pin pad attached to your computer you will need to press the “Manual

Entry” button on the pin pad and type the credit card information on the pin pad.
d. Once the card processes, you will see the approved message on xCharge.
e. Select the okay button and close xCharge.
f. Pull up the corresponding patient Accounts
g. Change your payment type to Insurance Credit Card and process the payment as

usual. The only change you will make is to uncheck the box for “Charge Card” on the
Insurance payment window and only print one receipt.

EFT Payment Information
EFT payments, also known as Electronic Funds Transfers, are the fastest, most efficient way to receive
insurance reimbursement. The following approximations apply to the named carrier.

Carrier EOB/EFT Date vs Deposit Date Displays on Account
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Aetna 5 Days “Aetna”

Anthem 4 days “Anthem”, “Rocky Mtn Health”, or
“Community Insurance”

Cigna 4 days “Cigna”

Delta Typically true to date on EOB “Delta”

Humana 3 days “Humana”, “HHPEF”, or “HDIC”

Medicaid 1 day after payment information is available
on website

Metlife Typically true to date on EOB “Metlife”

United Concordia “UCCI” or “UCD”

It is a best practice to input the EFT into Eaglesoft for the same date that the transaction arrives in the
office’s bank account. This will ensure a smooth process when doing monthly reconciliations. To further
manage this, you will want to check the bank account daily for the items that are posted the day before.
This will help to ensure you don’t have a backlog of EFTs to rush to enter before the end of the month.

Some offices have found it helpful to print a list of the previous day's credits from the bank account and
treat it like a checklist for the EFTs and Payment Plans to be found and entered for the previous day.

Where to Find/Printing EOBs/EFTs
The Insurance Contact, Benefits, and Payment Information section in the Appendix lists where you can find
the insurance company's EFTs. Keep in mind that this may vary slightly. You can always call an insurance
company and request copies of the EOBs or EFT payments if you are unable to locate them online. You
don’t want to let an EFT payment sit there unreconciled because this can cause unnecessary delays in
entering a patient's payments.

Handling Research/Narrative Requests
When a claim is rejected we must review the EOB to understand not only why it is being rejected, but also
what action needs to be taken to correct the errors and how we need to handle the employer moving
forward.

● If the patient is unable to be located: Did we submit using a SSN or a subscriber id? Is the employer
set up to use the SSN or subscriber id? Do we have the correct individual listed in Eaglesoft as
subscriber versus what the insurance verification states?

● If the eob states that the patients coverage was no longer in effect: Did we submit to the correct
carrier?

○ Review SmartDocs to ensure that we submitted to the most recently verified insurance
carrier.

○ Contact the patient to see if there were any changes to their insurance coverage.
When an EOB is needing to be escalated to the doctor for narrative or review

1. Initial Review - EOB needing review by the doctor for narrative or escalated research.
2. OMFS Specialist Review
3. Endo Specialist Review
4. Awaiting Review - EOBs that have been resubmitted with pertinent information, scanned into

SmartDoc for our records, and account noted using “###” note.
a. Ensure that these claims are being reviewed weekly for follow up.

5. A/R Report by responsible party - The doctors will be actively reviewing/working this report and
adjusting accounts as needed.
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When the doctor completes the narrative/appeal, they will deliver it back to the front office to be
faxed/mailed to the insurance carrier. The front will scan into the patient’s SmartDoc the outbound appeal.

Handling Denials and Write-Offs
When denials are received from insurance it is imperative to research why the services are being denied
and make the appropriate adjustments or resubmissions if necessary.

● Were appropriate attachments made (i.e. pre- or post-operative Xrays and perio charting submitted
as needed…)?

● Did we walk out quadrants of the mouth or tooth numbers (UL and LL versus 18-19 and 30-31)?
● Do the tooth numbers line up with the type of service being submitted (i.e. anterior teeth versus

posterior teeth)?
● Does the service accurately reflect the patient's age (i.e. adult prophylaxis versus child prophy)?
● Was the patient eligible? (i.e. frequency, age, replacement clause on existing work, etc…)?

When the following services are denied due to frequency they should be written off immediately:
● D0140
● D0220
● D0272
● D0274
● D0330
● D1351
● D2950

When the following services are denied they should immediately be deleted and resubmitted as the noted
code:

● D0150 resubmit as D0120
○ If D0120 is also denied, resubmit as D0140

Handling Payments Received for Another Office
There may be times when a payment is sent to the wrong office. When this happens the following needs to
happen:

1. If the payment is an EFT
a. The payment needs to be entered into Patient Access Fees
b. A “$$$” note will be made stating that a “payment was received in the amount of $XX for

patient -- --, for services rendered on DOS MM/DD/YYYY. Email sent to offices to locate
patient. III”

c. An email will be sent to offices@openandaffordable.com (distribution list that sends email to
all offices) with a copy of the EOB stating that a payment was received at the office and
patient is not seen at that office.

d. When the patient’s office reaches out a check from the receiving office will be sent along
with a copy of the EOB to the patients home office who will enter the payment following the
normal process as though the check was received from an insurance carrier.

2. If the payment is a Check:
a. An email will be sent to offices@openandaffordable.com (distribution list that sends email to

all offices) with a copy of the EOB stating that a payment was received at the office and
patient is not seen at that office.

b. When the patient’s office reaches out the check and corresponding EOB will be sent to the
patient’s home office.

c. The patients home office who will enter the payment following the normal process as though
the check was received from and insurance carrier.

3. If the Payment is an Insurance Credit Card:
a. An email will be sent to offices@openandaffordable.com (distribution list that sends email to

all offices) with a copy of the EOB stating that a payment was received at the office and
patient is not seen at that office.
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b. When the patient’s office reaches out the insurance credit card may be discarded.
c. The home office will print off the EOB and virtual credit card that was initially send and enter

the payment following the usual process.
**If the office is receiving a lot of payments that are for other offices: copies of the EOBs need to be sent to
Sherry at doctors@openandaffordable.com, so she can help the office figure out why they are being sent to
the wrong place.

When trying to apply a payment but there are no open claims displayed for the
patient
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Processing Payment Plans
Much like EFTs these will be checked and entered that day after they post to the account. They will show
up on the office’s bank account as “MERCHANT BANKCD”. To get the corresponding reports for these
payments you will need to use CardPointe and do the following:

1. Login into the CardPointe system using the office’s specific login credentials.
2. Navigate to Reporting → Gateway Batches
3. Then select the corresponding Batch Number to the dollar amount you are seeking.
4. Right click and print the first page of the resulting page.
5. Then you will go to each patient’s account listed on the report and post the payment for the

previous business day as a payment plan payment.
6. The Batch Report will then be included at the end of your Day Sheet packet.

**NOTE: It is important to make sure that you never combine payments when you are entering payment
plans. You want the payments to be reflected as they post to the account. It causes confusion for the
corporate representatives during monthly reconciliation if there are combined amounts.

Calling on Declined Payment Plans
It is important to review Card Pointe for declined payment plans and attempt to contact the patient
to resolve those issues. To do this you will go to the Card Pointe website and

Accounts Receivable
The front office is to collect all the money that is produced. It is Open and Affordable Dental’s goal to collect
at least 95% of last month’s production. It is also important to never have more than one month’s account
production in accounts receivable. For example, if last month’s production was $100,000, this month’s
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account receivables should be no more than $100,000. It is imperative that a strict collection policy is
implemented.

Accounts Receivable Reports
There are several reports to help the front in keeping track of the office Accounts Receivables. These
reports need to be run monthly by the doctor to ensure the Accounts Receivables does not exceed last
month’s production. It may be appropriate to assign one front office person per doctor to increase
accountability by the doctor for collections.

Accounts Receivable Balance Total and by Account
Practice Management → Reports → Financial → Accounts Receivable by Provider → Detailed →
Sort → Balance, uncheck Ascending.

The sum of the provider balance is the actual Accounts Receivable balance.

It is important to review each account with the doctor on this report monthly to review outstanding claims,
unpaid balances, and accounts that are uncollectible. Write-offs may only be made with the approval of the
doctor. Any account notes, write-offs, adjustments must include the reason for the entry and the initials of
the person making the adjustment.

Accounts Receivable By Responsible Party (Aging)
Practice Management → Reports → Insurance → Accounts Receivable By Responsible Party
This report allows the aging of accounts receivable to be used to understand the immediacy of collecting on
the account.

Outstanding Claims By Insurance Company
Practice Management → Reports → Insurance → Outstanding Claims By Insurance Company →
Select Appropriate Date Range
This report details the outstanding claims per insurance company. It is imperative that this report is run
monthly to ensure no claims exceed their payable date. For example, Colorado Medicaid only pays claims
submitted within 120 days from its service date.

End Of Month Process (Corporate)
Eaglesoft End of Month - Processing on System
End of Month will be set up to process automatically by the doctor and/or the Administrative Staff
Coordinator following the steps below:
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Monthly Eaglesoft DaySheet/Bank Account Deposit Reconciliation

Monthly Reconciliation Checklist
Prior to the corporate representative coming to the office, the following must be completed:
⬜ All Day Sheets must be organized and checked for accuracy (this should be done daily as part of

the EOD process).
⬜ All EFTs must be input for the month that they arrive in the bank account (to the day is ideal).
⬜ The Daily Funding report for the month needs to be printed from Care Credit
⬜ If the office uses an intermediary bank, the deposit transactions for the month from that institution.

You will print from the 1st through the date containing the last bank deposit for the month.
⬜ Trade Monies programs reports, such as Colorado Currency or ITex, are printed for the month.
⬜ Primary bank account transactions for the month will be downloaded and imported into the Monthly

Reconciliation spreadsheet on Google Drive (My Drive → Office Folders → Office Monthly
Numbers). You will print from the 1st through the date containing the last bank deposit for the
month.

Monthly Reconciliation Process
By the 10th of each month, a member of the corporate team will reconcile each bank deposit for the prior
month to ensure completeness and accuracy. The accuracy of the deposits ensures all transactions are
posted to the correct patient account and no embezzlement is occurring.

1. The member of the corporate team will review all Day Sheets as the front office checks the Monthly
Reconciliation Master spreadsheet to confirm each bank entry.

2. Items will be highlighted and/or marked as the amounts are encountered and verified by both
parties.

3. All Day Sheet category totals will be verified against the bank deposits to ensure completeness and
accuracy.

a. Cash and checks will be added together by the member of the corporate team and then
verified against the amount stated on the Day Sheet.

b. Credit card deposits and insurance credit cards will be added together and compared
against the amount of the banking account deposit.

c. Care Credit deposits will be compared to the Daily Funding Report as that is the amount that
will be posted to the bank.

d. EFTs will be verified individually and then totaled to be compared by the corporate
representative against the Day Sheet.

4. The previous month’s deposit printout will also be consulted to ensure no gaps in deposit
transactions.

5. Once all Day Sheets are verified for accuracy and completeness, they are packaged and filed by
month/year.

6. The owner/doctor will then verify the remaining transactions and mark them appropriately.
In the event of a discrepancy
All discrepancies will be resolved and a new Deposit Report with Itemized Cash will be printed and
stapled to the front of the daily batch.

1. It is expected that any apparent discrepancies be resolved before the monthly deposit
reconciliation.

2. It is not the corporate representative's responsibility to help the front correct discrepancies
between the Day Sheets and the bank download.

3. The world “OLD” will be written on the previously used Deposit Report with Itemized Cash.
4. Any discrepancy between deposits and Day Sheets must be immediately resolved and a

new Day Sheet will be printed.
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End Of Year Process
Eaglesoft End of Year - Processing on System
End of Year will be set up to process automatically by the doctor and/or the Administrative Staff Coordinator
following the steps below:
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Front Office Training Protocol & Core Competencies
During the training time it is imperative that the trainee make the best use of this time. Come prepared with
the office manual and ready to make notes about the processes outlined within. The trainer will have the
trainee review the corresponding manual sections as necessary.

Day 1: Eaglesoft, Scheduling, & Communication Systems
Attire Guidelines, Workspace Guidelines Periodontal Charting

OSHA, HIPAA, & CPR, Office Communications Checking Email, Weave, ZocDoc, and WebChat

Value of New Patients, Patient Flow Through Office Office Opening and Closing Procedures

Answering Frequently Asked Questions Processing Inbound Mail/Packages

Inbound Telephone Calls Access Other Office’s EagleSoft Using Splashtop

Dental Procedure Descriptions SmartDoc Document Management, Faxing

Appointment Notes, OP3 Patients, OP4 Patients

Scheduling, Appointment Confirmation Printing Envelopes, Returned Letters

Patient Check In, Routing Sheets, Patient Check Out Records Release, Ordering Office Supplies

Inbound Lab Cases, End Of Day Processes Social Media

Day 2/3: Insurance Verification & Entering New Insurance Plans
Open and Affordable Discount Plan Fillable Benefit Breakdown Form

HMO/DMO Insurance Plans, Medicare Plans Locating Patient Benefit Breakdowns

Credentialing, Insurance Verification Frequencies Secondary Insurance - Coordination of Benefits

Unfamiliar Insurance Carriers, Verifying Insurance Entering Insurance Plans, Discount Plans

Required Benefit Breakdown Information

Day 3/4: Out-Bound Claims Processing

Review the process for out-bound claims Submit secondary insurance claims with proper
attachments

Review and process claims that don’t need
attachments. Print and mail claims (with attachments as needed).

Make proper attachments to claims that require them. Closing, reopening, & re-submitting claims.

Day 5/6: In-Bound Claims Processing (Payments), Research, & Accounts
Enter checks from insurance companies. Enter insurance EFT payments.

Enter insurance credit cards. Review procedures for denials & narrative requests.

Review where to locate EOBs.

Day 6: Completion
Run scheduled shift with trainer observing. Review available resources to trainee post-training.
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Front Office Daily Task List (Date: ____________________)
The following daily task list needs to be followed and completed daily. Initial each task as it is completed.

Check Weave messages and faxes.

Check over the day for any insurance that has not been verified and verify them.

Check email for: patient messages and/or missed communications.

Print schedule 3 business days out. Check for missing items (NP Forms or Edit Pt info) and note that in Appointment Notes.

Insurance verification (min. 3 business days out). Add ** to all unverified Insurance. Note on the appt that insurance is verified.
Confirmation calls - 1 business day (completed by 10 am).

Call any appts that are listed as and make additional notes on appt if additional messages are left.

Verify if appts marked as need to be called or switched to .

Confirmation calls - 2 business day out (completed by 11 am). Statuses are Confirmed or Left Message only

Fill in open hygiene schedule using:
☐ Quickfill
☐ Next week, same day of week: 1. New Patients, 2. SRPs, or 3. Discount Plan(s)

Reminder calls - 4 week minus a day (Completed by 12 pm). Update 4 week appointment confirmation status.

Appointment reminder system “Confirmed” switch to “Other”

Sent Email (4 week) = Left Message (2 business day), Other (4 week) = Confirmed (2 business day)

Review red blocks in notes section (for payments, insurance needs, etc… ) deleting all completed tasks.

Check in lab cases and attach to appointments. Schedule patients with unappointed lab cases as they are received.

Deposit the previous day’s deposit at the bank and check USPS.

Separate mail into the following:
Bills → Doctor’s Inbox, Checks → To Be Processed folder, EOB denials→ To Research folder, Junk → Garbage

Process incoming insurance check/payments.

Check EFTs, print EOBs:☐ Aetna☐ Anthem☐ Cigna☐ Delta☐ Humana☐ Medicaid☐ Metlife☐ Pay Plus☐ UHC

Check CardPointe for payment plans:☐ Post Processed Payments☐ Call on Declined Payments

Verify all past appts are walked out. Ensure all past appts are clean (ins. in caps, all pts walked out, no *’s, etc...).

Stock all new patient paperwork, discount plan forms, and all consent forms.

Empty shredder and stock all printers with paper.

Print routing slips for next business day, highlighting outstanding balances.

Process Day Sheet (Deposit Report with Itemized Cash), print credit card settlement, and process EOD on EagleSoft..

Process EOM and/or EOY if needed, before beginning new month. Logging in as if it is the last day or month of month or year
**The following items are done throughout the day

Scan all paperwork in the scan pile and shred all items in the shred pile.

Process outbound claims (maximum 3 days without processing).

Review the in process claims to ensure that none are greater than 60 days old.

Review any claim denials received: correct, resubmit, or write-off appropriately.

Continue to check messaging systems.

Update office social media.

Update/Complete all tasks in your Task Manager.

Verify that the previous night's backup was successful and switch out the hard-drive on the server computer.

Review no shows & excused absence patient histories. Apply Op3 designation as appropriate.

Remove the Discuss Finances patient alert for all patients that paid balances today.

Call previous No Show and Excused Abscess appointments under Need To Be Rescheduled blocks to reschedule pts.

Doctor’s signature of completion before crew change: _____________________________________________________________
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Front Office Weekly, Monthly, Annual Tasks
Weekly Tasks (Week Of ____________________)
The following daily task list needs to be followed and completed weekly. Initial each task as it is completed.

Clean printer scanner areas.

Empty shredder.

Empty trash cans in front office, lobby, employee and patient bathrooms, and breakroom.

Sweep and mop front desk area, lobby, and common areas (if office does not have a cleaning crew).

Wipe down employee side of front desk with Lysol wipes.

Wipe down lobby surfaces, including chairs, door knobs, shelves, etc...

Clean out keyboards and mice with canned air and wipe down with cavi.

Restock patient and employee bathrooms (soaps, paper towels, etc…).

Clean mirrors and wipe down sinks in employee and patient bathrooms.

Clean toilets in employee and patient bathrooms.

Clean, organize, and restock breakroom space.

Review supplies and order as appropriate.

Wipe down monitors with monitor wipes.

Delete benefit breakdowns, xrays, and scans from computers.

Doctor’s signature of completion before crew change: _____________________________________________________________

Monthly Tasks (Month Of ____________________)
The following daily task list needs to be followed and completed monthly. Initial each task as it is completed.

Process EOM before beginning new month. Logging in as if it is the last day or month of month or year.

Thorough dusting of all lobby decor - including lighting fixtures.

Clean windows.

Empty computer recycle bins.

Compare EFTs with primary bank account that all Payments have been entered.

Review lobby reading materials and remove/replace as needed.

Doctor’s signature of completion before crew change: _____________________________________________________________

Annual Tasks (Year Of ____________________)
The following daily task list needs to be followed and completed annually. Initial each task as it is completed.

Process EOY before beginning new year. Logging in as if it is the last day or month of month or year.

Verify and update provider credentials displayed in lobby.

If office has carpeting, schedule to have carpet cleaned.

Arrange for corporate team to pick up documents (EOM packets from prior year). Retain 6 months at most in office.

Verify if the office needs to do CareCredit mandatory Re-Certification training and complete as needed.

Verify if the office needs to do Self-Assessment Questionnaire through ControlScan (www.mycontrolscan.com)

Medicine cabinet: Verify expiration dates on medications and reorder expired medications.

Medicine cabinet: Check the batteries and pads in AED. Replace/reorder as needed.

Doctor’s signature of completion before crew change: _____________________________________________________________
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Front Office Development/Promotion Plan
At Open and Affordable Dental and Braces we strive to provide clear paths to employee advancement.
After excelling in your career as a front desk there are a variety of positions available including Answering
Service, Accounts Receivable Specialist, Administrative Staff Coordinator, and more! Keep in mind that the
first step in any development program is to have a thorough understanding of your current position.

Answering Service

Accounts Receivable

Administrative Staff Coordinator/Director
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Accounts Receivable Training Protocol & Core Competencies
During the training time it is imperative that the trainee make the best use of this time. Come prepared with
your office manual and ready to make notes about the processes outlined within. The trainer will have the
trainee review the corresponding manual sections as necessary.

Day 1: Eaglesoft & Communication Systems
Logging into other offices using Splashtop Download weave, connect computer and phones

Download Connecteam, go over how to switch
between offices

Download Google Spaces, learn to navigate and
create tasks

Understand how to navigate Inside Desk Understand how to view and navigate claims

Go over checking email, create labels for offices Go over necessary patient information for claim
submissions

Locate patients in Eaglesoft Go over claims submissions and what codes need
which attachments

Connect patients to the same account Go over x-rays and how to identify each type

Understand difference between primary subscriber
and responsible party on EagleSoft Go over tooth numbers, anterior vs posterior

Import & scan documents in SmartDocs Understand which exams need documentation and
how to check that those have been completed

Day 2/3: Insurance Verification & Understanding Eligibility
Discuss what insurance is, how it works, & what plans

we take.
Review where to look up EOBs for each insurance

company,

Perform online insurance verifications.
Including: Delta Co, Cigna, Metlife, Principal, etc... Print EOBs and highlight important information.

Perform Medicaid verification
Including making appropriate notes.

Understanding breakdowns and how to investigate
frequency/limitations for each code

Go over primary and secondary insurance, how to
determine which to use as primary Learn how to create/edit employers

Review what coverage books are & when to use them.
Including amalgam downcodes & exceptions to ES category
%

Login into Card Pointe, learn to navigate website

Day 3/4: Out-Bound Claims Processing

Review the process for out-bound claims. Submit secondary insurance claims with proper
attachments.

Review and process claims that don’t need
attachments. Print and mail claims (with attachments as needed).

Make proper attachments to claims that require them. Closing, reopening, & re-submitting claims.

Day 5/6: In-Bound Claims Processing (Payments), Research, & Accounts
Enter insurance payments and notes

Creditcard payments, check, EFT payments Review procedures for denials & narrative requests

Understand the importance of account notes and when
to use which note

Understand how to read account notes and research
documents in SmartDocs

Go over adjustment/adjustment types Go over the process for updated insurance with old
open claims
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Day 6: Completion

Run scheduled shift with trainer observing. Review available resources to trainee after training
ends.
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Accounts Receivable Daily Task List (Date: ____________________)
The following daily task list needs to be followed and completed daily. Initial each task as it is completed.

Log onto Weave and check all messages and Faxes.

Check over your day for any Insurance that has not been verified and verify them.

Check email for: patient messages and missed communications via appointment reminder system.

Check that we have lab cases in for today's appointments.

Print schedule 3 business days out. Check for missing items (NP Forms or Edit Pt info) and note that in Appointment Notes.

Insurance verification (min. 3 business days out). Add ** to all unverified Insurance. Note on the appt that insurance is verified.

Confirmation calls - 1 business day (completed by 10 am).

Call any appts that are listed as and make additional note on appt if additional message is left.

Verify if appts marked as need to be called or switched to .

Confirmation calls - 2 business day out (completed by 11 am). Statuses are Confirmed or Left Message only

Fill in open hygiene schedule using:
☐ Quickfill
☐ Next week, same day of week: 1. New Patients, 2. SRPs, or 3. Discount Plan(s)

Reminder calls - 4 week minus a day (Completed by 12 pm). Update 4 week appointment confirmation status.

Appointment reminder system “Confirmed” switch to “Other”

Sent Email (4 week) = Left Message (2 business day), Other (4 week) = Confirmed (2 business day)

Review red blocks in notes section (for payments, insurance needs, etc… ) deleting all completed tasks.

Check in lab cases and attach to appointments. Schedule patients with unappointed lab cases as they are received.

Deposit previous day deposit at bank, ensure petty cash = $200, check USPS.

Separate mail into the following:
Bills → Doctor’s Inbox, Checks → To Be Processed folder, EOB denials→ To Research folder, Junk → Garbage

Process incoming insurance check/payments.

Check EFTs, print EOBs:☐ Aetna☐ Anthem☐ Cigna☐ Delta☐ Humana☐ Medicaid☐ Metlife☐ Pay Plus☐ UHC

Check CardPointe for payment plans:☐ Post Processed Payments☐ Call on Declined Payments

Verify all past appts are walked out. Ensure all past appts are clean (ins. in caps, all pts walked out, no *’s, etc...).

Stock all new patient paperwork, discount plan forms, and all consent forms.

Empty shredder and stock all printers with paper.

Print routing slips for next business day, highlighting outstanding balances.

Process Day Sheet (Deposit Report with Itemized Cash), print credit card settlement, and process EOD on EagleSoft..

Process EOM and/or EOY if needed, before beginning new month. Logging in as if it is the last day or month of month or year
**The following items are done throughout the day

Scan all paperwork in scan pile and shred all items in shred pile.

Process outbound claims (maximum 3 days without processing).

Review the in process claims to ensure that none are greater than 60 days old.

Review any claim denials received: correct, resubmit, or write-off appropriately.

Continue to check messaging systems.

Update office social media.

Update/Complete all tasks in your Task Manager.

Verify that the previous night's backup was successful and switch out the hard-drive on the server computer.

Review no shows & excused absence patient histories. Apply Op3 designation as appropriate.

Doctor’s signature of completion before crew change: _____________________________________________________________
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Accounts Receivable Weekly and Monthly Tasks
(Location:_____________)
Weekly Tasks (Week of: ____________________)

The following daily task list needs to be followed and completed daily. Initial each task as it is completed.

Print and highlight all EFTs deposited for the week.

Input all EFTs with proper notes and write offs.

Process all insurance checks and credit card payments with proper notes and write offs.

Call all patients with new balances and collect.

Check CardPointe for payment plans:☐ Post Processed Payments☐ Call on Declined Payments

Update/Complete all tasks in your Task Manager.

Record collections and production numbers for the week.

Monthly Tasks (Month of: ____________________)
The following daily task list needs to be followed and completed daily. Initial each task as it is completed.

Print Accounts receivable by responsible party

Go over accounts with BOAs, figure out if they are true balances, enter all required notes and write offs.

Call patients to collect after figuring out true balance.

Go over accounts with COAs, figure out if they are true credits, enter all required notes.

Record collections and production numbers for the month.

Process EOM and/or EOY if needed, before beginning the new month.
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Answering Service Daily Task List (Date: ____________________)
The following daily task list needs to be followed and completed daily. Initial each task as it is completed.

Any correspondence via Weave/Wix needs to end with your first name!

Opening Procedure

Log onto the Weave desktop application using your personal login.
☐ Any correspondence via Weave needs to end with your first name!
☐ Reply to voicemails left, missed calls, and unread text messages.

Log onto the Wix website, make sure the notifications are enabled.
Username: info@openandaffordable.com
Password: Buffalo@13

☐ Any correspondence via Wix needs to end with your first name!
☐ Reply to missed chats.
☐ Check for appointment requests for offices that are closed and schedule following the scheduling protocol.

The following items are done throughout the shift

Answer all inbound calls.

Continue to monitor and respond to Weave voicemails and texts. Make a list of responded to voicemails by phone number, to
ensure responded voicemails are not recontacted when responding to missed calls.

Respond to all missed calls that have not been previously responded to in the voicemail protocol.

Respond to messages received on Wix. Respond only to scheduled appointment requests if the offices are closed on the day
the appointment is received.

Verify insurance for any appointment scheduled by Answering Service when an office is closed. If the office is open, a
message is sent to the office alerting of the appointment and their need to verify insurance. After-hours Answering Service verifies all
insurances that are downloadable. Notes are left for the in-office fronts to verify any insurance that is not downloadable.

Complete 4 week, 2 day, and 1 day confirmation calls for offices with staffing shortages. (Upon request per office)
☐ Location Requests: ______________________________________________________________

Verify insurances for same day and 1 day appointments for offices with staffing shortages. (Upon request per office)
☐ Location Requests: _____________________________________________________________

Closing Procedure

Relay information for any active message(s) patients have not responded back to the Answering Service Signal group.

Wipe down all counter tops and phones.

Take trash out.

Sweep/mop floors.

Log out of any Eaglesoft sessions used by Answering Service at all offices.

Answering Service Administrator signature of completion before crew change: ________________________________
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OS Front Office Daily Task List (Date: ____________________)
The following daily task list needs to be followed and completed daily. Initial each task as it is completed.

Treatment Plans: Treatment plan 15 days prior to each OS Day
LOCATION(S): ______________________________________________________________________________________________
Task List:
☐ Upload NPF from original office (if applicable)
☐ Upload pano from original office if it has been taken within the last 12 months (if applicable)
☐ Verify patient insurance OS codes (D7XXXs to D9612)
☐ Compare patient chart and x-rays to proposed codes. Correct and add codes as needed
☐ Call insurance to verify any frequency or coverage discrepancies to ensure accurate treatment plans. ALWAYS call
on implant treatment plans. Verify missing tooth clause on implant treatment plans.
☐ Create treatment plan in Eaglesoft
☐ Correct all fee amounts as necessary
☐ Add patient out of pocket (OOP) to Appointment Note with Answering Service initials

14 Day Call: If patient is contacted, set confirmation to Confirmed = . If patient is not contacted, set confirmation to Other = .
LOCATION(S): ______________________________________________________________________________________________
Things to Discuss with Patient:
☐ Insurance coverage and patient out of pocket expenses
☐ Date, time, location
☐ Upcoming 7 day confirmation call. Specialty Front Office will reconfirm all details of appointment at 7 days prior.

14 Day Recall: Review the previous OS day for the above locations. Call all the patients who did not confirm or show up
for their appointment and scheduled them for the next OS day. These patients are considered OP3 patients. Alerts should
be applied if not already applied to the patient.

LOCATION(S): ______________________________________________________________________________________________
Things to Discuss with Patient:
☐ Insurance coverage and patient out of pocket expenses
☐ Date, time, location
☐ Upcoming 7 day confirmation call. Specialty Front Office will reconfirm all details of appointment at 7 days prior.

7 Day Call: All appointments are contacted for confirmation. If patient is contacted, set confirmation to Confirmed = . If patient is not

contacted, set confirmation to Left Message = and move appt to the Notes column on the schedule.
LOCATION(S): ______________________________________________________________________________________________
Things to Discuss with Patient:
☐ Insurance coverage and patient out of pocket expenses
☐ Date, time, location
☐ Review pre/post op instructions then send instructions to patient via Weave text message

3 Day Call: Review and call all appointments on the OS production schedule that are not confirmed. Review and call all appointments on the

Notes column that have been left messages. If patient is contacted, set confirmation to Confirmed = . If patient is not contacted, set confirmation to

Left Message = and move/leave appt to the Notes column on the schedule.
LOCATION(S): ______________________________________________________________________________________________
Things to Discuss with Patient:
☐ Insurance coverage and patient out of pocket expenses
☐ Date, time, location
☐ Review pre/post op instructions then send instructions to patient via Weave text message

Claims: All OS claims need to be submitted by the first business day after being in the clinic. Review claim processing/payment for the
previous OS day.
LOCATION(S): ______________________________________________________________________________________________

Newly Scheduled OS Appointments: Follow 3 Day Call protocol for all OS appointments scheduled in-office less than 3 days from OS clinic
day.

OS Administrator signature of completion before crew change: _____________________________________
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Common Dental Codes - Attachment Guide

Diagnostic (Exam) Major Restorative (Crowns) Prosthodontics (Relines)

D0150 Comprehensive exam D2792 Full Cast D5730 Upper Complete

D0120 Periodic exam D2740 Porcelain/Ceramic D5731 Lower Complete

D0140 Limited exam D2950 Buildup D5740 Upper Partial

D0180 Perio evaluation D2954 Post and Core D5741 Lower Partial

D2920 Recement Crown

Diagnostic (Xray) Implant
D0210 FMX Endodontics (Root Canal) D6010 - Surg place of Implant

D0220 1st PA D3310 Anterior D6057- Custom Abutment

D0230 Additional PA D3320 Premolar D6058 - Abutment Supported
Porcelain Crown

D0272 2 Bitewings D3330 Molar D6104 Bone Graft - Implant Place

D0274 4 Bitewings D7953 Bone Graft - Extraction

D0330 Panoramic Periodontics
D4341 Scaling and Root Planing Oral Surgery (Extraction)

Preventative D4342 1-3 Teeth Limited SRP D7140 Simple

D1110 Adult Prophy D4355 Full Mouth Debridement D7210 Surgical

D1120 Child Prophy D4910 Perio Maintenance D7220 Soft Tissue

D1206 Fluoride Varnish D7230 Partial Bony

D1351 Sealant Prosthodontics (Dentures) D7240 Full Bony

D5110 Complete Upper D7250 Root Tip

Basic Restorative (Fillings) D5120 Complete Lower

D2330 Ant. Composite 1 surface D5130 Immediate Upper

D2331 Ant. Composite 2 surface D5140 Immediate Lower

D2332 Ant. Composite 3 surface D5213 Upper Partial

D2335 Ant. Composite 4 + surface D5214 Lower Partial

D2391 Post comp 1 surface D5225 Upper Valplast

D2392 Post comp 2 surface D5226 Lower Valplast

D2393 Post comp 3 surface

D2394 Post comp 4 + surface

Needs pano and perio charting
Needs preoperative xrays (include intraoral photos if available)
Needs postoperative xrays
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Generalized Insurance Guidelines

Aetna: Crowns:
● D2740 if downcoded =
● Build ups cov’d same day as crown
● Pays on Seat

Periodontics:
● D4341 = 4 quads same day
● D4342 = 4 quads same day
● Prophy & SRP same day =

Ameritas: Crowns:
● D2740 if downcoded =
● Build ups cov’d same day as crown
● Pays on Prep

Periodontics:
● D4341 = 4 quads same day
● D4342 = 4 quads same day
● Prophy & SRP same day =

BCBS: Crowns:
● D2740 if downcoded = D2791
● Build ups XXX cov’d same day as crown
● Pays on Seat

Periodontics:
● D4341 = X quads same day
● D4342 = X quads same day
● Prophy & SRP same day =

Cigna: Crowns:
● D2740 if downcoded = D2791
● Build ups NOT cov’d same day as crown
● Pays on Seat

Periodontics:
● D4341 = 4 quads same day
● D4342 = 4 quads same day
● Prophy & SRP same day =

Delta: Crowns:
● D2740 if downcoded = D2750/2790

Depends on tooth number! Looks like 2nd molars = D2790
● Build ups cov’d same day as crown
● Pays on Seat

Periodontics:
● D4341 = 2 quads same day
● D4342 = 4 quads same day
● Prophy & SRP same day =

GEHA: Crowns:
● D2740 if downcoded =
● Build ups cov’d same day as crown
● Pays on Seat

Periodontics:
● D4341 = 4 quads same day
● D4342 = 4 quads same day
● Prophy & SRP same day =

Guardian: Crowns:
● D2740 if downcoded =
● Build ups cov’d same day as crown
● Pays on Prep

Periodontics:
● D4341 = 4 quads same day
● D4342 = 4 quads same day
● Prophy & SRP same day =

Humana: Crowns:
● D2740 if downcoded =
● Build ups cov’d same day as crown
● Pays on Prep

Periodontics:
● D4341 = 4 quads same day
● D4342 = 4 quads same day
● Prohy & SRP same day =

Medicaid: Crowns:
● D2740 if downcoded =
● Build ups NOT cov’d same day as crown
● Pays on Prep

Periodontics:
● D4341 = 2 quads same day
● D4342 = 4 quads same day
● Prophy & SRP same day = Yes

Metlife: Crowns:
● D2740 if downcoded = D2790
● Build ups cov’d same day as crown
● Pays on Prep

Periodontics:
● D4341 = 4 quads same day
● D4342 = 4 quads same day
● Prophy & SRP same day =

Principal: Crowns:
● D2740 if downcoded =
● Build ups cov’d same day as crown
● Pays on Prep

Periodontics:
● D4341 = 4 quads same day
● D4342 = 4 quads same day
● Prophy & SRP same day =
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Sun Life: Crowns:
● D2740 if downcoded =
● Build ups cov’d same day as crown
● Pays on Seat

Periodontics:
● D4341 = 4 quads same day
● D4342 = 4 quads same day
● Prophy & SRP same day =

UHC: Crowns:
● D2740 if downcoded =
● Build ups NOT cov’d same day as crown
● Pays on Prep

Periodontics:
● D4341 = 2 quads same day
● D4342 = 4 quads same day
● Prophy & SRP same day = Yes

UCCI: Crowns:
● D2740 if downcoded =
● Build ups cov’d same day as crown
● Pays on Seat

Periodontics:
● D4341 = 4 quads same day
● D4342 = 4 quads same day
● Prophy & SRP same day =
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Insurance Contact, Benefits, & Payment Information

Carrier Phone # Fax # Obtain Benefits Obtain EFTs/EOBs
Aetna 800-451-7715 860-754-9187

859-455-8650
Call for faxback. Their website. Navigate to: Search

Explanation of Benefits → EOB
Search → Search by Payment →
Select the TIN and choose a date
range to generate all EFTs during that
time frame → Click “View EOB” to
generate a PDF to print.

Aetna Core Source 800-990-9058
Aetna Senior Products 800-264-4000
Aetna - EBMS 866-887-4118
Aetna - Medicare 800-282-5366
Aetna - Railroad 877-277-3368 Call for faxback

Aflac 800-992-3522 Their website: code by code; five at
a time

Always Care 855-400-9330
Ameriben 866-955-1498
AmeriPlan 800-647-8421
Ameritas 800-487-5553 402-467-7339
Anthem (Facility #-----)

Provider Relations #
800-627-0004
866-947-9398

Availity Website

Anthem BCBS: WellPoint
Provider Relations #

800-262-4496
800-627-0004

805-383-1792

Auxiant 800-475-2232
BCBS - Federal Emp 800-852-5957
BCBS - FEP Blue 855-504-2583
BCBS - Regence 800-253-0838
BCBS of CA
BCBS of FL Availity Website

BCBS of ID 855-216-6850
BCBS of IL 800-367-6401
BCBS of KS 800-432-0272 Availity Website

BCBS of MA 800-882-1178
BCBS of MI 888-826-8152
BCBS of MN 877-604-2142
BCBS of MT 800-447-7828
BCBS of ND 888-772-4256
BCBS of NE 800-991-5801 Availity Website

BCBS of OK 888-381-9727
BCBS of SC 800-222-7156
BCBS of TN 800-788-6684 Availity Website

BCBS of TX 800-451-0287
BCBS of WY 800-251-1814
Beam Insurance Administrators 800-648-1179
Beta 800-807-0706
Careington International/Great West 800-441-0380 469-252-5930

469-252-5933
Their website.

Cigna 800-537-8204 860-731-2989 Their website and call about
downcode information and to see if
endo, perio, and oral surgery are
covered at basic or major rates.
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Cigna - Great West
Cigna - Seafarers Health and Bene
CNIC Health Solutions 800-426-7453
Cofinity 800-831-1166
Colorado Carpenters Dental 844-313-0449
Companion Life 800-753-0404 Their website - physically print the

breakdown then go through and
write in the percentages on the
breakdown next to each category.

Comprehensive Healthcare Options 303-667-0794
Connection Dental 800-505-8880

xt 4047
816-257-7339

Coventry Health 800-969-3343 724-741-7322
Delta National Portal Their website will take you to Dental

xChange for the ERAs (Navigate to:
View Delta Dental ERAs → Select the
link for Unprocessed ERAs under the
Quick Links heading → Locate the
Delta Dental Carrier and the amount
that corresponds to the EOB you are
looking for and choose the “Print”
option under the actions column →
Ensure that only the Add Claim
Payment Summary is checked on the
ERA Print Menu and select “OK” →
Print as usual

Delta Dental Ins Co - Alabama see DDIC - GA

Delta Dental of Alaska 888-374-8906
Delta Dental of AZ 800-352-6132
Delta Dental of AR 800-462-5410 Their website.

Delta Dental of CA 800-548-5468 Their website.

Delta Dental of CA - Federal 855-410-3255
Delta Dental of CA - Military 844-825-8111
Delta Dental of CO 800-610-0201 303-741-2230 Their website. Their website. Navigate to: Provider

Login → DDPA → Payments and
select the EFT # under the “Check”
column.

Delta Dental CT see Delta Dental of NJ

Delta Dental of DW see Delta Dental of PA

Delta Dental Ins Co - FL see DDIC - GA

Delta Dental Ins Co - GA 800-521-2651
Hawaii Dental Service 800-232-2533
Delta Dental of ID 800-356-7586
Delta Dental of IL 800-323-1743
Delta Dental of ID 800-524-0149
Delta Dental of IA 800-544-0718
Delta Dental of KS

Faxback Bene Line →
800-234-3375
877-329-3357

Delta Dental of KY 800-955-2030
Delta Dental Ins Co - LA see DDIC - GA

Delta Dental of MD see Delta Dental of PA

Delta Dental of MA 800-872-0500 Their website.

Delta Dental of MI 800-524-0149
Delta Dental of MN 800-448-3815 Their website.

Delta Dental Ins Co - MS see DDIC - GA
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Delta Dental of MO 800-335-8266
Delta Dental Ins CO of MT see DDIC - GA

Delta Dental of NB 800-448-3815
Delta Dental of NJ 800-452-9310 Their website.

Delta Dental of NM 877-395-9420
Delta Dental of NY see Delta Dental of PA

Delta Dental of NC 800-662-8856
Delta Dental of ND 800-448-3815
Northeast Delta Dental (ME,NH,VT)

Fax-Back Bene Line →
800-832-5700

800-253-7852
Delta Dental of OH 800-524-0149
Delta Dental of OK 800-522-0188
ODS Companies (Delta OR) 800-452-1058
Delta Dental of PA 800-932-0783
Delta Dental of PA - AARP 866-261-4275
Delta Dental of PR 939-205-3300
Delta Dental of RI 800-843-3582
Delta Dental of SC 800-335-8266
Delta Dental of SD 800-627-3961
Delta Dental of TN 800-223-3104
Delta Dental Ins Co - TX see DDIC - GA

Delta Dental Ins Co - UT see DDIC - GA

Delta Dental of VA 800-237-6060 Their website.

Washington Dental Service 800-554-1907
Delta Dental of WV see Delta Dental of PA

Delta Dental of WI 800-236-3712
Delta Dental of WI - Individual Plans 888-899-3734
Delta Dental of WY 800-735-3379

Dental Benefit Providers (DBP) 877-816-3596 877-572-3043
Dental Directory Services 800-435-2232 888-821-3331
Dental Health Alliance/Assurant 800-434-2638
Dental Select 800-999-9789
Dental Wellness Partners 866-335-4892 866-335-4893
Dentegra 888-216-8316
Dentemax 800-752-1547 248-327-9299
Direct Dental Plans of America 800-377-2924 Their website.

EMI Health 800-644-5411
Five Star Dental 800-622-8489
Freedom Life Ins Co of America 800-387-9027
GEHA 877-434-2336
Guardian/Dental Guard 800-890-4774 303-761-1695 Their website. Downcode

information is typically available
within the procedure category

Health First Colorado 844-235-2387
Humana 800-833-2223 888-891-0728

305-370-6472
Call for faxback Their website (Navigate to: Dental

Providers → View Provider Payments
under the Payments section → Under
“Search Type” select EFT Deposit
Date → Enter a range of dates in the
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field and select submit → Under
“Single Remit Download” click the PDF
icon to open a popup containing a
download → Click refresh on the upper
right of the pop-up to show the active
link for the download

Kansas City Life 800/874/5254
Lincoln Financial Group 800-423-2765 877-843-3945
LineCo 800-323-7268
Manhattan Life 800-999-2971
Medicaid 855-225-1731 Their website. Their website (Navigate to:

Claims/Pre-Authorizations/Referrals →
Explanation of Benefits → and select
the EFT Trace Number under the
“Results” column towards the left)
If the required EOB does not display it
may have accidentally been marked as
reconciled. To find it you will need to
select Payments → click Search →
select Expand filters + → choose All
from the Status drop down menu →
click Filter. Now you should be able to
scroll through the results list and locate
the EFT that you are missing.

Medico 800-822-9993
Meritain Health 800-925-2272
Metlife 877-638-3379 Their website. There will be a

minimum of 4 pages to print for full
verification and up to 6 if there are
downcodes (downcodes for fillings
are found in the notes section at the
bottom of the procedure category).

ERA system in EagleSoft

Mutual of Omaha 877-999-2330
National Elevator Industry 800-252-4611 610-557-4555
Northwest Teamsters 800-872-5439
NTCA 828-281-9000 Call for verbal benefits breakdown.

Pay Plus (aka Zelis) Their website (Navigate to: Login →
Payment Portal Login → Payments →
Payments → then select the payments
you need to print using the checkbox
at the front of the row → click the
“Download” button at the top of the row
to download the EOBs)

Principal 800-247-4695 866-393-0761 Their website to request a fax-back
that will provide more detail than
the breakdown online

Reliance Standard Life Insurance 800-497-7044
Renaissance 888-358-9484
Sun Life Financial/Assurant 800-442-7742 Their website.

Standard Insurance Co 800-547-9515
TeamCare 800-323-2190
Total Dental Administrators Their website.

UMR 866-868-9789 Their website. Optum website

United Commercial Travelers 800-848-0123
United Concordia 800-332-0366 717-260-6834 Their website. Navigate to: “Payments

& EOBs” → expand the date range to
before the date of deposit → select
search → Select the provider in the
window → select submit at the bottom
→ click the EOB that corresponds to
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the deposit amount and/or EFT #
United Concordia - Active Duty 888-286-8454
United Healthcare Dental 877-816-3596 Their website. ERA system in Eaglesoft or Their

Website. Navigate to: “EOB/Details” for
the amount you are looking for under
the “Recent Claims” section on the
right

United of Omaha Life Ins Co 877-999-2330
UNUM 855-400-9330
Veterans Administration **They will fax or email us patients

to contact for appointments.
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Verifying Insurance by Insurance Company

Easy

Medicaid - Colorado (Medicaid ID)

1. Drag the Dentaquest webpage to the second monitor.
2. Log into Dentaquest website with saved username/password. This password should be saved in

Google Chrome’s office profile.  The username/password is also saved in the office’s Google Drive
password document.

3. Select Member → Check Eligibility
4. Select the correct provider from the Provider dropdown list.
5. Enter DOB into the Birth Date field.
6. Enter the patient’s Member ID into the Member Number field.  If the Member ID is not available,

search using the patient’s DOB, first, and last name.  Copy the Member ID once it’s found using the
patient’s DOB, first, and last name.

7. Select the member using the Member Name link.
8. Inspect the Coverage End Date at the upper right corner of the window.

a. If the patient’s coverage has terminated, it will have a past date listed.  Designate the
coverage terminated by adding an “*IE” to the Prefered Name field in Eaglesoft.

9. If the patient is an adult (>=21), the maximum benefits should be entered as “$1500” in the
Eaglesoft Rem. Benefits: field.  If the patient is a child (<21), the maximum benefits should be
entered as “$999999.99” in the Eaglesoft Rem. Benefits: field

10. Inspect the Remaining benefits in the lower right of the window.  If the balance is less than the
Eaglesoft Rem. Benefits:, copy the Dentaquest Remaining to Eaglesoft.  If EagleSoft’s Rem.
Benefits is less than the Dentaquest Remaining benefits, leave the EagleSoft Rem. Benefits as
is.

11. Select the Edit Patient → Memo button and enter the following sentence, “**VERIFIED VIA
DENTAQUEST <<Verified Date>> <<ELIGIBLE/INELIGIBLE>> <<Front Office Initials>>”

12. Ensure the Member ID is entered into the Edit Patient → Pref. Name field and copied to the
Eaglesoft Edit Patient → Preferences → Medicaid ID: field.

13. Add “<<Verified Date>> INS VERIFIED <<Front Office Initials>>” to the Appointment Note.

Delta CO (Policy Holder Member ID)

1. Ensure to create both the subscriber and dependant (member) profiles before verifying insurance.
2. If the member is a dependent, the Edit Patient → Policy Holder and Responsible Party check

boxes are left blank.  The Responsible Party checkbox is used to link families together found in the
Family Member picklist.  Other family members are selected by right clicking their names in the
Family Member picklist.

3. The Has Primary/Secondary Insurance checkboxes are checked and the appropriate Policy
Holder: is selected.

4. Drag the Delta CO webpage to the second monitor.
5. Log into Delta CO website with saved username/password. This password should be saved in

Google Chrome’s office profile.  The username/password is also saved in the office’s Google Drive
password document.

6. Select the Sign in/Register link at the top right of the webpage.  Select Provider from the
dropdown list.

7. Enter in the member’s ID into the SUBSCRIBER ID OR SSN * field.
a. If the member’s ID is not known, utilize the subscriber’s SSN.

8. Enter the member first name in to the FIRST NAME * field.
9. Enter the member’s DOB into the DOB * field.
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10. Select the Search button.
11. Inspect the Termination Date in the middle of the window.

a. If the patient’s coverage has terminated, it will have a past date listed.  Designate the
coverage terminated by adding an “*IE” to the Prefered Name field in Eaglesoft.

12. Ensure the Delta CO Group Name and Group Number match exactly in the Eaglesoft Edit Patient
→ Edit Employer → Name: and Group Number: fields.

a. Group numbers should be truncated from “000000W1039-0000000001-0000000001” to
“W1039-0001-0001” in the Eaglesoft Group Number: field.

13. Inspect the INDV Prevention First Except Ortho Cal Yr (PPO) remaining benefits Total allowed and
Remaining balances from the middle of the webpage.

14. If the balance is less than the Eaglesoft Rem. Benefits:, copy the Delta CO Remaining to
Eaglesoft.  If EagleSoft’s Rem. Benefits is less than the Delta CO Remaining benefits, leave the
EagleSoft Rem. Benefits as is.

15. Inspect the Individual Annual Deductible (PPO) balance at the bottom of the webpage.
16. If the balance is less than the Eaglesoft Rem. Deduct:, copy the Delta CO Remaining to Eaglesoft.

If EagleSoft’s Rem. Deduct: is less than the Delta CO Remaining deductible, leave the EagleSoft
Rem. Deduct: as is.

17. Ensure the member ID is copied to the Edit Patient → Preferences → Primary Member ID: field.
18. Ensure the member’s SSN is entered in the Edit Patient → Soc. Sec: field.
19. Select the Don’t see information you need? Click here to view full benefits information for

<<Member Name>>. link at the bottom of the webpage.
20. Inspect the Covered Benefits on the 3rd page of the Benefit Summary Report.
21. Ensure the Delta CO We Pay → PPO Service Types match the Eaglesoft → Edit Employer →

Service Type → Percent.
22. Ensure the Delta CO Deductible flag → PPO Yes/No matches the Eaglesoft → Edit Employer →

Service Type → Deductible Applies Yes/No checkbox.
23. Ensure Eaglesoft Edit Patient → Edit Employer → Preferences → ID Policy Holder By: →

Policy Holder Member ID and Identify Patient By: → None radio buttons are selected.
24. Note any Delta CO Benefit Summary Report → Covered Benefits → Waiting Period Satisfied

values and note any exception on the Eaglesoft Appointment Note.
a. Apply the Edit Patient → Alerts → Waiting Periods/Frequencies/Complex Ins if a waiting

period applies.
25. Download the Benefit Summary Report as a .pdf to the Downloads folder using the print link at

the top right of the In-Chrome .pdf.   Select Destination → Save as PDF.  Name the file
“<<Member First Initial>> <<Member Last Name>> ELG”

26. Open the member’s Eaglesoft SmartDoc and select File → Import → then select the downloaded
eligibility PDF.

27. Add “<<Verified Date>> INS VERIFIED <<Front Office Initials>>” to the Appointment Note.

Metlife (Social Security Number)

1. Ensure to create both the subscriber and dependant (member) profiles before verifying insurance.
2. If the member is a dependent, the Edit Patient → Policy Holder and Responsible Party check

boxes are left blank.  The Responsible Party checkbox is used to link families together found in the
Family Member picklist.  Other family members are selected by right clicking their names in the
Family Member picklist.

3. The Has Primary/Secondary Insurance checkboxes are checked and the appropriate Policy
Holder: is selected.

4. Drag the Metlife webpage to the second monitor.
5. Log into Metlife website with saved username/password. This password should be saved in Google

Chrome’s office profile.  The username/password is also saved in the office’s Google Drive
password document.

6. Select the SIGN IN link at the top left of the webpage.
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7. Enter in the subscriber’s SSN  into the Enter the subscriber's Social Security or Identification
Number: → Eligibility/Plan field.

8. Inspect the Eligibility Dates → Cancellation Date: for termination of policy.
a. If the patient’s coverage has terminated, it will have a past date listed.  Designate the

coverage terminated by adding an “*IE” to the Prefered Name field in Eaglesoft.
9. Select the member Name link.
10. Select the appropriate provider Name link.

a. Ensure the appropriate provider is listed as In Network → Yes on the webpage.  If the
provider is listed as In Network → No, call Metlife at 1-877-638-3379 to verify the provider’s
In/Out Network status.

11. Ensure the Metlife Patient Summary → Group Name: and Group Number: fields match exactly
with the Eaglesoft Edit Patient → Edit Employer → Name: and Group Number: fields.

12. Inspect the BASIC PLAN - Out of Network → Benefit Period Individual and Maximum Used to Date
balances from the middle of the webpage.

13. If the balance is less than the Eaglesoft Rem. Benefits:, copy the Metlife → Maximum Used to
Date to Eaglesoft.  If EagleSoft’s Rem. Benefits is less than the Metlife → Maximum Used to Date
benefits, leave the EagleSoft Rem. Benefits as is.

14. Inspect the BASIC PLAN - Out of Network → Deductible Satisfied to Date balance in the middle of
the webpage.

15. If the balance is less than the Eaglesoft Rem. Deduct:, copy the Metlife → Deductible Satisfied to
Date to Eaglesoft.  If EagleSoft’s Rem. Deduct: is less than the Metlife → Deductible Satisfied to
Date, leave the EagleSoft Rem. Deduct: as is.

16. Ensure the member’s SSN is entered in the Edit Patient → Soc. Sec: field.
17. Select Metlife → Benefit Levels, Frequency & Limitations from the left side of the webpage.
18. Ensure the Metlife PROCEDURE CATEGORIES - Out of Network Service Types match the

Eaglesoft → Edit Employer → Service Type → Percent.
19. Ensure the Metlife Deductible flag → Yes/No matches the Eaglesoft → Edit Employer → Service

Type → Deductible Applies Yes/No checkbox.
20. Ensure Eaglesoft Edit Patient → Edit Employer → Preferences → ID Policy Holder By: →

Social Security Number and Identify Patient By: → None radio buttons are selected.
21. Select the Metlife → Maximums & Deductible link. Download the Maximums & Deductible as a

.pdf to the Downloads folder by right clicking on webpage → right click → Print….   Select
Destination → Save as PDF.  Name the file “<<Member First Initial>> <<Member Last Name>>
ELG1”

22. Select the Metlife → Benefit Levels, Frequency & Limitations link.  Download the Benefit
Levels, Frequency & Limitations as a .pdf to the Downloads folder by right clicking on webpage
→ right click → Print….   Select Destination → Save as PDF.  Name the file “<<Member First
Initial>> <<Member Last Name>> ELG2”

23. Select the Metlife → Patient Summary link.  Download the Patient Summary as a .pdf to the
Downloads folder by right clicking on webpage → right click → Print….   Select Destination →
Save as PDF.  Name the file “<<Member First Initial>> <<Member Last Name>> ELG1”

24. Open the member’s Eaglesoft SmartDoc and select File → Import → then select each downloaded
eligibility PDF.

25. Add “<<Verified Date>> INS VERIFIED <<Front Office Initials>>” to the Appointment Note.

Cigna (Policy Holder Member ID)

1. Ensure to create both the subscriber and dependant (member) profiles before verifying insurance.
2. If the member is a dependent, the Edit Patient → Policy Holder and Responsible Party check

boxes are left blank.  The Responsible Party checkbox is used to link families together found in the
Family Member picklist.  Other family members are selected by right clicking their names in the
Family Member picklist.
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3. The Has Primary/Secondary Insurance checkboxes are checked and the appropriate Policy
Holder: is selected.

4. Drag the Metlife webpage to the second monitor.
5. Log into Cigna website with saved username/password. This password should be saved in Google

Chrome’s office profile.  The username/password is also saved in the office’s Google Drive
password document.

6. Select the Log In link on left of the webpage.
7. Select Patients → Search Patients webpage menu.
8. Enter the member’s SSN into the Patient ID (or SSN) field.
9. Enter the member’s DOB into the Patient Date of Birth field.
10. Inspect the Coverage Date(s) field for termination of policy.

a. If the patient’s coverage has terminated, it will have a past date listed.  Designate the
coverage terminated by adding an “*IE” to the Prefered Name field in Eaglesoft.

11. Select the Patient ID link.
12. Ensure the Cigna Patient and Plan Detail → Account Name and Account Number fields match

exactly with the Eaglesoft Edit Patient → Edit Employer → Name: and Group Number: fields.
13. Inspect the Benefit Maximums → Total: and Individual Calendar Year Maximum remaining balances

from the middle right of the webpage.
14. If the balance is less than the Eaglesoft Rem. Benefits:, copy the Cigna → Individual Calendar

Year Maximum remaining to Eaglesoft.  If EagleSoft’s Rem. Benefits is less than the Cigna →
Individual Calendar Year Maximum remaining benefits, leave the EagleSoft Rem. Benefits as is.

15. Inspect the Deductible → Individual Calendar Year Deductible remaining balance in the middle left
of the webpage.

16. If the balance is less than the Eaglesoft Rem. Deduct:, copy the Cigna → Individual Calendar Year
Deductible remaining to Eaglesoft.  If EagleSoft’s Rem. Deduct: is less than the Cigna →
Individual Calendar Year Deductible remaining, leave the EagleSoft Rem. Deduct: as is.

17. Ensure the member’s ID is entered in the Edit Patient → Preferences → Primary Member ID:
field.

18. Expand the Cigna → Coinsurance - Patient's Coinsurance Percentage and Cigna → Frequency
& Limitations dropdowns on the webpage.

19. Ensure the Cigna Coinsurance - Patient's Coinsurance Percentage Service Types match the
Eaglesoft → Edit Employer → Service Type → Percent. Note, the percentages listed by Cigna is
how much the patient pays, so 0% on Cigna website means the Service Type is covered at 100%
in Eaglesoft.

a. It is assumed that Eaglesoft DIAGNOSTIC and PREVENTATIVE service types are covered
at the Cigna Diagnostic and Preventative percentage.

b. It is assumed that Eaglesoft RESTORATIVE BASIC and ENDODONTICS and
PERIODONTICS and ORAL SURGERY service types are covered at the Cigna Basic
Restorative percentage.

c. It is assumed that Eaglesoft DENTURES and RESTORATIVE MAJOR service types are
covered at the Cigna Major Restorative percentage.

d. It is assumed that all other Eaglesoft Service Types are covered at 0%.
20. It is assumed that all EagleSoft Service Types except for PREVENTATIVE and DIAGNOSTIC have

a deductible.  Ensure the Eaglesoft → Edit Employer → Service Type → Deductible Applies
Yes/No checkbox is set accordingly.

21. Ensure Eaglesoft Edit Patient → Edit Employer → Preferences → ID Policy Holder By: →
Policy Holder Member ID and Identify Patient By: → None radio buttons are selected.

22. Download the Cigna → Benefits as a .pdf to the Downloads folder by right clicking on webpage →
right click → Print….   Select Destination → Save as PDF.  Name the file “<<Member First
Initial>> <<Member Last Name>> ELG”

23. Open the member’s Eaglesoft SmartDoc and select File → Import → then select each downloaded
eligibility PDF.

24. Add “<<Verified Date>> INS VERIFIED <<Front Office Initials>>” to the Appointment Note.
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Humana (Social Security Number)

1. Ensure to create both the subscriber and dependant (member) profiles before verifying insurance.
2. If the member is a dependent, the Edit Patient → Policy Holder and Responsible Party check

boxes are left blank.  The Responsible Party checkbox is used to link families together found in the
Family Member picklist.  Other family members are selected by right clicking their names in the
Family Member picklist.

3. The Has Primary/Secondary Insurance checkboxes are checked and the appropriate Policy
Holder: is selected.

4. Drag the Humana webpage to the second monitor.
5. Log into Humana website with saved username/password. This password should be saved in

Google Chrome’s office profile.  The username/password is also saved in the office’s Google Drive
password document.

6. Select the Sign In link in the middle of the webpage.
7. Select Frequently Accessed Links → Eligibility and Benefits in the middle of the webpage.
8. Enter the member’s SSN without hyphens or Member ID into the Member ID: field.
9. Inspect the End Date field for termination of policy.

a. If the patient’s coverage has terminated, it will have a past date listed.  Designate the
coverage terminated by adding an “*IE” to the Prefered Name field in Eaglesoft.

10. Select the Member ID link.
11. Ensure the Humana Plans & Coverage Detail → Coverage information → Group name: and

Account Number fields match exactly with the Eaglesoft Edit Patient → Edit Employer → Name:
and Group Number: fields.

12. Inspect the Benefit Maximums → Total: and Individual Calendar Year Maximum remaining balances
from the middle right of the webpage.

13. If the balance is less than the Eaglesoft Rem. Benefits:, copy the Cigna → Individual Calendar
Year Maximum remaining to Eaglesoft.  If EagleSoft’s Rem. Benefits is less than the Cigna →
Individual Calendar Year Maximum remaining benefits, leave the EagleSoft Rem. Benefits as is.

14. Inspect the Deductible → Individual Calendar Year Deductible remaining balance in the middle left
of the webpage.

15. If the balance is less than the Eaglesoft Rem. Deduct:, copy the Cigna → Individual Calendar Year
Deductible remaining to Eaglesoft.  If EagleSoft’s Rem. Deduct: is less than the Cigna →
Individual Calendar Year Deductible remaining, leave the EagleSoft Rem. Deduct: as is.

16. Ensure the member’s ID is entered in the Edit Patient → Preferences → Primary Member ID:
field.

17. Expand the Cigna → Coinsurance - Patient's Coinsurance Percentage and Cigna → Frequency
& Limitations dropdowns on the webpage.

18. Ensure the Cigna Coinsurance - Patient's Coinsurance Percentage Service Types match the
Eaglesoft → Edit Employer → Service Type → Percent. Note, the percentages listed by Cigna is
how much the patient pays, so 0% on Cigna website means the Service Type is covered at 100%
in Eaglesoft.

a. It is assumed that Eaglesoft DIAGNOSTIC and PREVENTATIVE service types are covered
at the Cigna Diagnostic and Preventative percentage.

b. It is assumed that Eaglesoft RESTORATIVE BASIC and ENDODONTICS and
PERIODONTICS and ORAL SURGERY service types are covered at the Cigna Basic
Restorative percentage.

c. It is assumed that Eaglesoft DENTURES and RESTORATIVE MAJOR service types are
covered at the Cigna Major Restorative percentage.

d. It is assumed that all other Eaglesoft Service Types are covered at 0%.
19. It is assumed that all EagleSoft Service Types except for PREVENTATIVE and DIAGNOSTIC have

a deductible.  Ensure the Eaglesoft → Edit Employer → Service Type → Deductible Applies
Yes/No checkbox is set accordingly.
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20. Ensure Eaglesoft Edit Patient → Edit Employer → Preferences → ID Policy Holder By: →
Policy Holder Member ID and Identify Patient By: → None radio buttons are selected.

21. Download the Cigna → Benefits as a .pdf to the Downloads folder by right clicking on webpage →
right click → Print….   Select Destination → Save as PDF.  Name the file “<<Member First
Initial>> <<Member Last Name>> ELG”

22. Open the member’s Eaglesoft SmartDoc and select File → Import → then select each downloaded
eligibility PDF.

23. Add “<<Verified Date>> INS VERIFIED <<Front Office Initials>>” to the Appointment Note.

UHC (SSN/Policy Holder Member ID)

1. Ensure to create both the subscriber and dependant (member) profiles before verifying insurance.
2. If the member is a dependent, the Edit Patient → Policy Holder and Responsible Party check

boxes are left blank.  The Responsible Party checkbox is used to link families together found in the
Family Member picklist.  Other family members are selected by right clicking their names in the
Family Member picklist.

3. The Has Primary/Secondary Insurance checkboxes are checked and the appropriate Policy
Holder: is selected.

4. Drag the UHC webpage to the second monitor.
5. Log into the UHC website with the saved username/password. This password should be saved in

Google Chrome’s office profile.  The username/password is also saved in the office’s Google Drive
password document.

6. Select the Sign In link in the middle of the webpage.
7. Enter today’s date into the *Service Date field. Enter the members DOB into the *Member Date of

Birth and Member ID into *Subscriber ID
8. Inspect the Term Date: field for termination of policy.

a. If the patient’s coverage has terminated, it will have a past date listed.  Designate the
coverage terminated by adding an “*IE” to the Prefered Name field in Eaglesoft.

9. Ensure the UHC Group Name: and Group ID: fields match exactly with the Eaglesoft → Edit
Patient → Edit Employer → Name: and Group Number: fields.

10. Inspect the Annual Maximum Benefits - Dental → Used to Date and Annual Maximum Benefits -
Dental → Remaining balances from the middle right of the webpage.

11. If the balance is less than the Eaglesoft Rem. Benefits:, copy the UHC → Annual Maximum
Benefits - Dental → Remaining to Eaglesoft.  If EagleSoft’s Rem. Benefits is less than the UHC →
Annual Maximum Benefits - Dental → Remaining benefits, leave the EagleSoft Rem. Benefits as
is.

12. Inspect the Deductible balance in the middle left of the webpage.
13. If the balance is less than the Eaglesoft Rem. Deduct:, copy the UHC → Deductible to Eaglesoft.

If EagleSoft’s Rem. Deduct: is less than the UHC → Deductible, leave the EagleSoft Rem.
Deduct: as is.

14. Ensure the member’s ID is entered in the Edit Patient → Preferences → Primary Member ID:
field.

15. Expand the UHC → Coverage and Deductible and UHC → Benefit Breakdown dropdowns on
the webpage.

16. Ensure the UHC Coverage and Deductible Service Types match the Eaglesoft → Edit Employer
→ Service Type → Percent.

17. Inspect the UHC Benefit Breakdown.
a. If the last digits of the ID are the patient’s SSN:

i. Ensure Eaglesoft Edit Patient → Edit Employer → Preferences → ID Policy
Holder By: → Social Security Number and Identify Patient By: → None radio
buttons are selected.

b. If the last digits of the ID are NOT the patient’s SSN:
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i. Ensure Eaglesoft Edit Patient → Edit Employer → Preferences → ID Policy
Holder By: → Policy Holder Member ID and Identify Patient By: → None radio
buttons are selected.

18. Download the UCH → Coverage and Deductible as a .pdf to the Downloads folder by right
clicking on webpage → right click → Print….   Select Destination → Save as PDF.  Name the file
“<<Member First Initial>> <<Member Last Name>> ELG1”

19. Download the UCH → Benefit Breakdown as a .pdf to the Downloads folder by right clicking on
webpage → right click → Print….   Select Destination → Save as PDF.  Name the file “<<Member
First Initial>> <<Member Last Name>> ELG2”

20. Open the member’s Eaglesoft SmartDoc and select File → Import → then select each downloaded
eligibility PDF.

21. Add “<<Verified Date>> INS VERIFIED <<Front Office Initials>>” to the Appointment Note.

Principal (Policy Holder Member ID)

1. Ensure to create both the subscriber and dependant (member) profiles before verifying insurance.
2. If the member is a dependent, the Edit Patient → Policy Holder and Responsible Party check

boxes are left blank.  The Responsible Party checkbox is used to link families together found in the
Family Member picklist.  Other family members are selected by right clicking their names in the
Family Member picklist.

3. The Has Primary/Secondary Insurance checkboxes are checked and the appropriate Policy
Holder: is selected.

4. Drag the Principal webpage to the second monitor.
5. Log into the Principal website with saved username/password. This password should be saved in

Google Chrome’s office profile.  The username/password is also saved in the office’s Google Drive
password document.

6. Select the Log In link on the upper left of the webpage.
7. Select Find a patient now webpage button.
8. Enter the member’s SSN or Member ID into the Member ID/SSN field.
9. Enter the member’s DOB into the Patient Date of Birth: field.
10. Inspect the Active/Inactive icon field for termination of policy.

a. If the patient’s coverage has terminated, it will have a past date listed.  Designate the
coverage terminated by adding an “*IE” to the Prefered Name field in Eaglesoft.

11. Select the Eligibility and Benefits button.
12. Ensure the Principal Employer: and Employer Number: fields match exactly with the Eaglesoft

Edit Patient → Edit Employer → Name: and Group Number: fields.
13. Inspect the Calendar Year Maximum → Maximum: and Calendar Year Maximum → Remaining:

balances from the middle of the webpage.
14. If the balance is less than the Eaglesoft Rem. Benefits:, copy the Principal → Calendar Year

Maximum → Remaining: to Eaglesoft.  If EagleSoft’s Rem. Benefits is less than the Principal →
Calendar Year Maximum → Remaining: benefits, leave the EagleSoft Rem. Benefits as is.

15. Inspect the Calendar Year Individual Deductible → Remaining: balance in the middle of the
webpage.

16. If the balance is less than the Eaglesoft Rem. Deduct:, copy the Principal → Calendar Year
Individual Deductible → Remaining: to Eaglesoft. If EagleSoft’s Rem. Deduct: is less than the
Principal → Calendar Year Individual Deductible → Remaining:, leave the EagleSoft Rem.
Deduct: as is.

17. Ensure the member’s ID is entered in the Edit Patient → Preferences → Primary Member ID:
field.

18. Select the Full Benefit Breakdown PDF button on top right of page.
19. Ensure the Principal In Network PPO Benefits → Policy Pays Service Types match the Eaglesoft

→ Edit Employer → Service Type → Percent.
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a. It is assumed that Eaglesoft DIAGNOSTIC and PREVENTATIVE service types are covered
at the Principal Preventative percentage.

b. It is assumed that Eaglesoft RESTORATIVE BASIC and ENDODONTICS and
PERIODONTICS and ORAL SURGERY service types are covered at the Principal Basic
Restorative percentage.

c. It is assumed that Eaglesoft DENTURES and RESTORATIVE MAJOR service types are
covered at the Principal Major percentage.

d. It is assumed that all other Eaglesoft Service Types are covered at 0%.
20. It is assumed that all EagleSoft Service Types except for PREVENTATIVE and DIAGNOSTIC have

a deductible.  Ensure the Eaglesoft → Edit Employer → Service Type → Deductible Applies
Yes/No checkbox is set accordingly.

21. Ensure Eaglesoft Edit Patient → Edit Employer → Preferences → ID Policy Holder By: →
Policy Holder Member ID and Identify Patient By: → None radio buttons are selected.

22. Download the Principal → Benefits as a .pdf to the Downloads folder by right clicking on webpage
→ right click → Print….   Select Destination → Save as PDF.  Name the file “<<Member First
Initial>> <<Member Last Name>> ELG”

23. Open the member’s Eaglesoft SmartDoc and select File → Import → then select each downloaded
eligibility PDF.

24. Add “<<Verified Date>> INS VERIFIED <<Front Office Initials>>” to the Appointment Note.

Guardian (Social Security Number)

UCD/UCCI (Social Security Number)

Delta National

Careington

Ameritas

Dentemax

Companion Life

Hard

Aetna ()

BCBS

Standard

NEI

Liberty

Equitable

Delta WI (Individual)
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Tooth Eruption Chart
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Office Support Phone Numbers

Company Phone # Contact Name
Air Gas 303-286-4400

Aspen Dental Lab 303-745-8300

Brassler 912-656-2233

CardPointe 214-395-7057 Brian Berry

CareCredit 720-402-1849 Ryan

Comcast
Copac 303-320-5527 Garth

Cookson Builders, Inc. 207-852-8338 Todd

Dental Fix Rx 800-586-0340
308-631-9910

Tim

DentaQuest 720-645-2998

Dental Refiners 800-786-1742

Denver Water
Eaglesoft 800-475-5036

ESRTA
First Bank
Hayes Handpieces 800-228-0521

Henry Schein - Supplies 800-372-4346

Henry Schein - Service 800-645-6594

High Plains Bank 303-644-4900 Kathy

MedPro Disposal 888-641-6131

NEA FastAttach 800-782-5120

O&A Administrative Specialist Colton
colton.hale@openandaffordable.com

O&A Administrative Specialist Michelle
michelle.jimenez@openandaffordable.com

O&A AR Specialist 815-644-2092 Lindsey
lindsey.dierlam@openandaffordable.com

O&A Clinical Specialist 303-325-1752 Taylor
taylor.covello@openandaffordable.com

O&A Credentialing Specialist 623-297-7867 Sherry Stott
doctors@openandafforable.com

OpenEdge/xCharge 800-774-6462
888-414-7495

Patterson/EagleSoft 800-475-5036

Philips/Sonicare 303-817-2455

RingCentral 888-528-7464

114



Rocky Mountain Marketing 303-921-1709 Dick

Star Group Dental Refining 303-378-2468 Judd

TBK Bank
Ultradent 888-893-3792 Lindsey

Weave 888-579-5668 opt 1
opt 1 (software)
opt 2 (phones)

Dane Phone: 801-999-1838
Dane Email: dane.villamil@getweave.com
CS Email: multi-support@getweave.com
Chat:https://www.weavehelp.com/support

Wells Fargo 303-373-8612

Xcel Energy
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